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1. Sketch out key frames 

in CACANi. 

3. Generate In-between Frames. 

2. Clean up key frames. 

4. Paint 1 Frame as Colour Reference. 

5. Batch Paint Animation Frames. 

CACANi’s 

Animation 

Workflow 

Overview 
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CACANi is a revolutionary application developed with hand drawn animators 

in mind. With our proprietary tools and workflow, CACANi helps reduce the work 

required by generating in-between frames based on the key frames and automatically 

painting the frames, creating a smooth and realistic animation sequences in a fraction 

of the time. 

 

 Features of CACANi  

 Unique Pressure Sensitive Sketching and Tracing Capabilities 

With the use of graphic tablets or tablet displays, animators can choose to create their 

drawings with clean, uniform lines, or organic, pressure-sensitive strokes, directly in 

the software. 

 Colour Separation Line Layers 

To add more depth to the drawings, Colour Separation Lines can be drawn to create 

highlight or shaded regions. These special layers can then be hidden so that the final 

painted drawings do not show the separation lines. 
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 Automatic Generation of In-between Frames 

Animators can now make use of CACANi’s unique animation engine to automatically 

generate in-between frames after the key frames are drawn.  

 In-between Timing Adjustments 

Mimicking the hand drawn animation workflow, in-between timing can be easily 

adjusted via the Timing Panel. 

 Automatic Colouring of Animation Frames 

Using a single painted frame as reference, painters can auto-colour all the frames of 

an animation sequence. 

 Unique Digital Workflow for Hand Drawn Animation 

We have developed an alternative digital production pipeline to make full use of the 

many advantages of CACANi. It will improve or eliminate several tedious processes 

that are traditionally required in the hand drawn animation industry. 

 High Quality, Scalable Vector Output 

CACANi is able to export animation sequence of any size and quality. Because all 

graphics are vector-based, CACANi gives artists the freedom to distribute their 

creations on multiple platforms with ease, from large HDTVs to mobile devices. 
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The CACANi Animation Pipeline 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Rough out in CACANi 

(Sketch Layer) 

Load External Images 

(Reference Layer) 

Trace Key Frames (Stroke Matching / Manual Drawing) 

Animation Sequence Evaluation 

Generate In-between Frames (Timing) 

In-between Frames Adjustments (Bone Tool, Feature 

Point Tool) 

Paint Reference Colour Frame 

Auto-Colour Sequence 

Coloured Regions Clean Up / Manual Colouring 

Export Image Sequence / Video 

Gaps Clean up (Key Frames) 

Segment Hiding 

Draw 

In-between 

Clean Up 

Colour 

Export 

Import 

Complete ! 
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User Manual Icon Guide 

Throughout the user manual, you will encounter some icons describing specific 

interactions that you’ll need to perform with either the mouse or the digital stylus. 

They are listed as below: 

Left Click 

Press Left Mouse Button once (Mouse) or Tap Pen Tip on screen once (Stylus) 

Left Click Twice 

Press Left Mouse Button twice / Double Click (Mouse) or Tap Pen Tip on screen twice 

(Stylus) 

Left Click + Drag  

Press and Hold Down Left Mouse Button and Move in Indicated Direction (Mouse) or 

Press and Hold Down Pen Tip on screen and Move in Indicated Direction (Stylus) 

Right Click 

Press Right Mouse Button once (Mouse) or Press Pen Button once (Stylus) 

 

System Requirements 

Minimum Configuration 

2 GHz Intel® / AMD® processor 

Microsoft Windows XP 

512 MB RAM 

Video card supporting OpenGL 3.0 with at least 128 MB of RAM 

Monitor with at least 1024x768 resolution 

Mouse device 

  

Recommended Configuration 

3 GHz Intel® / AMD® processor 

Microsoft Windows 7 / 8 

At least 2 GB RAM  

Video card supporting OpenGL 3.0 with at least 1 GB of RAM 

Monitor with at least 1440x900 resolution 

Graphics Tablet or Tablet Monitor device 

  

Internet Connection will also be required for activation of software. 
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CHAPTER 02 – CACANi User Interface 
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CACANi USER INTERFACE 
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Understanding CACANi’s Interface 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is where you can find various 

controls for changing the display 

and behavior of tools and 

panels in CACANi. 

The Menu Bar is where you can 

find all the functions available in 

CACANi. 

This is where you can find additional 

controls for creating cels, frames and 

also playback your animation 

sequences in CACANi. 

The docking areas at the 

bottom and sides of CACANi 

are where you can place your 

panels so that they do not 

obstruct your canvas. 

The Property Bar lists the 

properties of the various 

tools in the Tool Panel. 



CACANi User Interface | CACANi 

21 | P a g e  

 

11 10 09 08 07 06 05 04 03 02 01 

Interface Overview - Full 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Playback 

Controls 

Canvas 

Menu 

Property Bar 

Lightbox 

Drawing Controls 
Display Property Bar 

Canvas Display 

Stroke Display 

Region Display 

Cel Bank 

Cel View 

Frame View 

Timing Panel 

Navigator 

Panel Access 

Colour Panel 

Frame Controls 

Tool Panel 

Cel Selection Bar 

Layer Panel 

Layer Selection Bar 
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Interface Management 

Panel Access Bar 

In CACANi, the various tools for animation are placed in Panels, and these are 

displayed (or hidden) via the Panel Access Bar, located at the top right corner of the 

workspace. 

 

 

 

 

 

 

 

 

 

Panel Docking 

Based on user preferences, Panels can be arranged to be either free-floating or 

attached/docked to the sides of the workspace.  

*Note that the Cel Bank is the exception: it can only be docked to the bottom. 

 

 

To dock a free-floating panel, drag it to the left, right, or bottom side of the 

workspace. The panel will snap into the enlarged dock area. 

     

Tool Panel 

Colour Panel 

Navigator 

Cel Bank 

Layer Panel 

Timing Panel 

Lightbox 
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A panel can also be docked in between other panels, or docked behind another 

panel. 

                                             

                 

 

When multiple panels are docked horizontally, left click and drag the empty dock 

area to move them together. 

                                   

 

Panels can be minimized by left-clicking twice on the panel tabs. 
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To close the panels, hover to the rightmost corner and left click on the ‘X’ icon. 

    

 

The docking area can be minimized by left clicking on the docking arrows. 

             

 

When there are too many docked panels, use the dock slider to navigate to the 

hidden panels. 

 

      

  



CACANi User Interface | CACANi 

25 | P a g e  

 

11 10 09 08 07 06 05 04 03 02 01 

Canvas Navigation 

There are several manners in which the canvas can be manipulated to change its 

view; one can move the canvas vertically or horizontally, rotate the canvas, zoom in 

or out and flip the canvas horizontally or vertically. 

 

Move around the Canvas  

1. Select Pan Tool from the Tools Panel. On the canvas, tap and drag the stylus.  

2. Press and hold [Spacebar]. Then on the canvas, tap and drag the stylus to pan. 

3. Enable the Navigator from the Panel Access Bar. Tap and drag the stylus in the 

preview window. 

 

 

Magnification of Canvas 

1. Select the Magnifying Tool from the Tools Panel. To zoom in, place the stylus on the 
canvas and drag to the right. Drag the stylus to the left to zoom out. 

2. Press and hold [Ctrl + Spacebar]. On the canvas, tap and drag the stylus Left to Zoom 
Out of the canvas, and drag Right to Zoom In to the canvas. 

3. Press [1] to Zoom Out of the canvas, press [2] to Zoom In to the canvas. 
4. Enable the Navigator from the Panel Access Bar. Use the Magnifying Tool, or type 

the magnification level in the input field. 

 

The preview window shows a 

thumbnail view of the canvas  

Magnifying Tool 

Tap and drag right to zoom 

into the canvas, drag left to 

zoom out of the canvas 

Magnification Level 

Tap on number for manual 

magnification level input.  

Input values from 1.6% to 

6400% 
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Canvas Rotation 

1. Select Rotate Tool from the Tools Panel. Drag with the stylus on the canvas to rotate 
the canvas around the center point of the drawing workspace.  

2. Press and hold [SHIFT + Spacebar]. On the canvas, tap and drag the stylus either 
Clockwise or Anti-Clockwise to rotate the canvas accordingly. 

3. Press [3] to rotate the canvas anti-clockwise, press [4] to rotate the canvas clockwise. 
4. Enable the Navigator from the Panel Access Bar. Use the Rotate Tool, or type the 

rotation angle in the input field. 

 

 

 

 

 

  

Rotation Angle 

Tap on number to perform manual 

rotation input.  

Input values from -180° to 180° 

Rotate Tool 

Tap and drag right to rotate the 

canvas clockwise, drag left to 

rotate anti-clockwise 
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Layer Panel 

 

 

 

 

 

 

        

 

 

 

 

 

 

 

 

 

The Layer Panel provides another means of layer manipulation other than the Cel 

Bank. 1 more option is available in this panel as compared to the Cel Bank: Show 

Custom Layer Colour function. 

To select a layer for drawing, simply tap / left click once on any layer. Stroke Colours 

are changed via the Colour Panel.  

For the Colour Separation Layers, stroke colours are determined by the Colour 

Separation Colours.  

*Note that it is not possible to draw on the Reference Layer. 

  

Delete Selected Layer 

Add Colour Separation Layer (Green) 

Add Colour Separation Layer (Red) 

Add Colour Separation Layer (Blue) 

Duplicate Layer 

Add Sketch Layer 

Add Reference Layer 

Add Layer 

 

Layer Name 

Layer Onionskin Property 

Layer Lock Property 

Layer Visibility Property 

  Custom Layer Colour 

Layer Opacity Input 

Layer Opacity Slider 

Lock Selected Layer 
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Layer Panel Operations 

To add a layer, simply press any of the Add Layer buttons in the Layer Panel.  

 

 

The order of the layers added are shown visually in the Layers Panel; strokes and filled 

regions in the topmost layer will hide strokes and filled regions in lower layers. 

  

 

To remove a layer, press the Delete Layer button after selecting the desired layer.  

 

 

Hold down [SHIFT] to select a range of layers in sequence, or [Ctrl] to select multiple 

layers in any order.  

    

Hold down [SHIFT] 

to select layers in 

sequence 

Selected 

Layer 
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You can also change the order of a layer by selecting the layer. First select the desired 

layer, then Left Click and Drag the layer to the desired position. It is also possible to 

select multiple layers in the same manner as mentioned above. 

Each layer has 4 properties: Layer Tag, Layer Visibility, Layer Lock and Layer Lightbox.  

 

Layer Tag 

Allows you to assign the layer with a specific colour for easier identification 

and selection. 

Layer Visibility  

Controls whether the contents in that layer will be shown on the canvas. 

Layer Lock 

Determines whether the contents in that layer can be modified.  

Layer Lightbox 

Determines whether the contents in the layer will be displayed as onion-skinned 

images. 

Left Click on the icons to enable or disable the respective properties. 

 

Change Drawing Layer Colour 

The Drawing Layers colours can be altered by Left Clicking Twice on the Drawing Layer 

Colour button in the panel.  

 

Hold down [Ctrl] 

to select layers in 

any order 

Selected 

Layer 
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A Colour picker dialog will appear to allow you to choose the colour. Click OK to 

confirm your selection or Cancel to preserve the previous colour. 

 

 

Colour Separation Layers 

Used for strokes that define highlight and shadow regions on the canvas. These layers 

are added by left clicking on the Add Colour Separation Layer Buttons.  
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Customising Shortcuts 

From the menu bar, select File > Customise Shortcuts. 

A dialog box will appear showing the category and commands with shortcuts in 

CACANi. 

 

 

 

 

Functions and Commands Tabs 

Lists of all user assignable functions and commands in CACANi, organized in tabs. 

Menu Functions / Commands Selection 

Allows you to choose the menu function or command you want to assign a 

shortcut for. 

Currently Assigned Shortcut 

Shows you the shortcut that is currently assigned to the function or command. 

New Shortcut Assignment 

Allows you to enter a shortcut for the selected function or command. 

Assign Shortcut Button 

Once a shortcut is entered, you can click this button to confirm the shortcut 

assignment. 

Clear Shortcut Button 

Allows you to remove a currently assigned shortcut to the selected function or 

command. 

Import and Export Shortcuts Buttons 

Allows you to load or save user assigned shortcuts via CACANi shortcut (.csc) files. 

Reset All Shortcuts Button 

1 

2 

3 4 

5 

7 8 

6 

1 

2 

3 

4 

5 

6 

7 

9 

8 
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Allows you to remove all user assigned shortcuts and revert to the original state. 

Confirmation Buttons 

Allows you to confirm changes and exit the dialog box by clicking Ok, or remove 

changes by clicking Cancel. 

 

Assigning Shortcuts 

Toggle and Hold Shortcuts 

Other than the typical keyboard shortcut assignments, CACANi also has a unique 

system of shortcuts that allows you to toggle tools instead of switching to them. 

First, a list of the tabs in the shortcuts dialog: 

        

   

   

 

   

9 

Menu Commands Shortcuts 

Tool Commands Toggle Shortcuts Tool Commands Hold Shortcuts 

Tool Panels Display Shortcuts Other Commands Shortcuts 
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In the Tools (Toggle) and Tools (Hold) tabs, the tools listed are similar. This is because 

for those commands, you can choose to either configure a toggle shortcut for it, or a 

hold shortcut.  

For example, the keyboard shortcut [Q] is assigned to the Selection tool. 

A Toggle shortcut is where, after you press and release [Q], the active tool will change 

and remain as the Selection tool until you choose another tool to switch to. 

A Hold shortcut is where the active tool changes and remains as the Selection tool as 

long as [Q] is held down. The moment you release [Q], the active tool reverts to your 

previous tool. 

This is useful for artists who tend to use only a few tools, but need to switch to other 

tools occasionally. 

 

Procedure for Assigning Shortcuts 

You can assign shortcuts easily by going into the File Menu, then choosing Customise 

Shortcuts. In this example, we are going to change the toggle shortcut for the 

Selection tool. Currently, [Q] is assigned to the tool. 

 

 

 

 

 

 

 

 

When the shortcut [W] is entered into the New Shortcut field, CACANi warns that the 

shortcut has already been assigned to another tool, the Stroke Editor.  
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Ignoring the first warning and clicking the Assign Shortcut button will bring up 

another warning.  

 

 

Finally, clicking the OK button will make CACANi change the shortcut to [W], and 

remove the original shortcut assignment. Note that the Stroke Editor does not have 

any shortcut assigned to it now.  
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CHAPTER 03 – The Menu Bar 

 

 

03 

The Menu Bar 
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CACANi Menu Options 

 

The Menu Bar holds various menus that allow you to control or change various 
features in CACANi.  

 

File Menu 

 

 

New   

Creates a new file. If a file is currently being worked on, a dialog will prompt 

whether to save the current work.  

Open  

Opens a previously saved file.  

Save  

Saves the current work. If the current work was not saved before, a dialog will 

prompt on the name and the type of file to save to.  

Save As  

Saves the current work as a different file. A dialog will prompt for the name and 

the type of file to save to.  

(See Chapter 10 - Saving the Animation) 
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Import File  

Opens a CACANi Essential Format (.cspe), CACANi XML (.cacx), or Scalable Vector 

Graphics (.svg) file to work on.  

Export Image  

Exports the current frame, all frames or selected frame as images. A dialog will 

prompt you for the format, name, resolution and other settings of the images. 

(See Chapter 10 – Exporting the Animation) 

Recent Files List  

Records the last 5 files that were in use for easier access. 

Customise Shortcuts  

Brings up the Shortcuts Customisation Panel  

(See Chapter 02 - Customising Shortcuts) 

Exit  

Exits CACANi software. If the existing work has not been saved, an ‘Unsaved 

Changes’ dialog box will appear. 
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Edit Menu 

 

Undo   

Undoes the previous action. Name of the previous action will be shown.  

Redo   

Repeats the next action. Name of the next action will be shown.  

Copy   

Duplicates and stores the selected strokes in the clipboard.  

Cut    

Remove the selected strokes from the canvas and place them in the clipboard. 

Paste  

Transfers the stored strokes back onto the canvas in the active sheet.  

Single Paste   

Transfers the stored strokes back onto the canvas in the active sheet, disregarding 

any stroke indices. 

Delete   

Removes the selected strokes from the canvas.   

Smart Paste Selected Strokes 

Unmatched strokes selected in the Navigator (Reference Frame mode enabled) 

are pasted into the active frame.    

Smart Paste All Strokes 

All unmatched strokes in the reference key frame are pasted into the active frame. 

Move Selected Element(s) Up/Down/Left/Right 1 Pixel 
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Translates the chosen strokes by a single pixel in the stated direction. 

Move Selected Element(s) Up/Down/Left/Right 10 Pixels 

Translates the chosen strokes by 10 pixels in the stated direction. 

Select All   

Makes a selection of all strokes on the canvas. 

Deselect   

Clears any current selection of strokes. 

(Enable / Disable) All Layers  

When enabled, stroke and frame operations will affect all layers.  

(Enable / Disable) All Frames 

When enabled, stroke and frame operations will affect all frames. 

Canvas… 

Opens a window that allows you to configure the resolution of the canvas, in 

pixels. 

Set Auto Save Location 

Allows you to change the folder where the auto-save files are stored in.  

Set Auto-saving Intervals 

Allows you to adjust the elapsed time before CACANi automatically makes a copy 

of your current file.  

Reset Panel Locations 

Reverts the various elements of CACANi to their default positions. 

 

View Menu 

 

Zoom in  

Magnifies the view of the canvas. 

Zoom out  

De-magnifies the view of the canvas. 
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Rotate CW  

Rotates the canvas clockwise. 

Rotate CCW   

Rotates the canvas Counter-Clockwise. 

Reset Canvas  

Removes any rotation, magnification and movement of the canvas. 

Reset Rotation  

Removes any rotation of the canvas. 

Reset Scale  

Removes any resizing of the canvas. 

Reset Translation  

Removes any movement of the canvas and moves it back to the center of the 

workspace. 

Flip Horizontal 

Flips the canvas along the Y axis.  

Flip Vertical 

Flips the canvas along the X axis.  

Auto Pan Reference Frame 

When enabled, the Navigator Panel display (Reference Frame mode enabled), will 

be moved together when panning the display in CACANi’s main canvas.  
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View > Canvas 

 
 

Show Camera Frame 

 Displays the camera frame on the canvas. 

Show Grid 

Displays a grid over the entire canvas. 

Show Field Chart 

Displays an animator’s field chart within the camera frame. 

Show Strokes’ Width 

Disables thickness and pressure of strokes and displays them as vector lines 

only. 

Show Strokes’ Directions 

Indicates the direction of a stroke with coloured arrows.  

Show Invisible and Hidden Strokes 

Displays invisible and hidden strokes on the canvas. 

Fade Non-Active Layers 

Distinguishes between strokes in active (selected) and non-active (unselected) 

layers. 

Grey Out Matched Strokes (Navigator only) 

(Only applicable to Navigator Panel, Reference Frame mode Enabled) Displays 

strokes that are already matched or corresponded will be as grey strokes, 

instead of the strokes’ original colour. 

Show Stroke Gaps 

 Indicates unconnected stroke ends. 

Show Hidden Stroke View 

Displays invisible strokes as black, and fades out visible strokes for easier 

drawing. 
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Show Colour Sep strokes 

Displays colour separation strokes on the canvas. 

Show Layer Tag Colours 

Displays stroke colours based on their layer colour tags.  

Toggle Lightbox 

Displays strokes from other frames as an onionskin image. 

Show Pins 

Indicates intersection points between strokes. 

Apply Anti-Aliasing to Strokes 

Enables stroke edge smoothening.  

 

View > Colour Regions 

 

 

Hide Region Colours 

Disables the display of painted regions. 

Show Region Colours 

Displays painted regions with their respective colours. 

Highlight Self Regions 

Indicates all self regions in all layers with checkered colours.    

Show Closed Regions 

Indicates all regions that are ready for painting in multiple colours. 

Show Painted Regions 

Indicates all filled regions in black. 

Show Closed Self Regions 

Displays only self regions found on the active layer.  

 

 



The Menu Bar | CACANi 

43 | P a g e  

 

11 10 09 08 07 06 05 04 03 02 01 

View > Quick Flip 

 

Quick Flip Forward 

Allows you to preview the animation from the current key frame to the next 

key frame by generating in-between frames temporarily.  

Quick Flip Backward 

Allows you to preview the animation from the current key frame to the 

previous key frame by generating in-between frames temporarily. 

 

 

Layer Menu 

 

New Cel  

Creates a cel above the selected cel in the Cel Bank. 

New Drawing Layer  

Creates a drawing layer above the selected layer in the Cel Bank. 

New Sketch Layer 

Creates a sketch layer above the selected layer in the Cel Bank. 

New Reference Layer  

Creates a reference layer above the selected Layer in the Cel Bank. 
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New Colour Separation Layer (Red, Blue, Green, Cyan, Pink, Yellow)   

Creates a colour separation layer above the selected Layer in the Cel Bank. Strokes 

drawn within the layer will not be shown in the final exported images. 

Duplicate Active Layer  

Clones the selected layer’s contents and place it in a new layer above the current 

selected one. 

Hide/Unhide Layer(s)  

Enable / Disable the visibility of selected Layers. 

Lock/Unlock Layer(s)  

Prevents the contents of selected Layers from being changed. 

Toggle Lightbox for Layer(s)  

Enable / Disable the onionskin images of selected Layers. 

Remove Cel(s) 

Delete the current selected Cel(s). 

Remove Layer(s)  

Delete the current selected Layer(s). 

Next Layer  

Selects the Layer beneath the current active Layer. 

Previous Layer  

Selects the Layer above the current active Layer. 

 

 

Frame Menu 

 

New Key Frame to Left/Right 

A new key frame is inserted before/after the selected frame. 
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New Tween Frame to Left/Right 

A new in-between frame is inserted before/after the selected frame.  

Duplicate Frame to Left/Right 

A clone of the selected frame is made and inserted before/after the original 

frame. 

Add Inbetween Frames to Entire Cel 

Allows you to create a fixed number of in-between frames for all keyframes in a 

cel. 

Adjust Stroke Width (Multi-Frame) 

Allows you to change the stroke width for all the frames in a layer. 

Remove Selected Frames  

Deletes selected frames from the Cel Bank. A Delete Confirmation Dialog box is 

shown. 

 
 

Left click on button [Yes] to delete the selected frames. Left click on button [No] 
to return to the workspace without deleting any frames. 

 
Remove All Tween Frames 

Deletes selected In-between frames from the Cel Bank. 

Clear Selected Frames / Selected Sheets / All Tween Sheets 

Clear all strokes in the selected frames / sheets / all tween sheets.  

 

 

Playback Menu 

 

Play  

Plays back the animation sequence. 

Move to Next Frame  

Selects the frame to the right as the active frame. 

 



User Manual 

46 | P a g e  

 

Move to Previous Frame 

Selects the frame to the left as the active frame. 

Move to Next Key 

Selects the nearest key frame to the right as the active frame. 

Move to Previous Key 

Selects the nearest key frame to the left as the active frame. 

 

 

Tools Menu 

 

Retain Stroke Connections (In-betweens) 

Analyses all frames for any T intersection gaps and auto close them. 

Go Previous Curve 

Allows you to revert to a previously unmatched stroke. 

Skip Next Curve 

Allows you to skip the next unmatched stroke. 

Auto Save  

When enabled, CACANi will automatically make a backup of the currently opened 

file at specific intervals. The duration can be configured via the Set Auto-saving 

Intervals option in the Edit menu. The backup folder can be configured via the Set 

Auto Save Location option in the Edit menu. It is enabled by default. 

Colour Reference Window  

Opens up a window that allows you to load an image for colour reference. 

Remove Redundant Place Holder for Current Layer 

Analyses the frames in the active layer and reduces the number of blank stroke 

placeholders. 
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Clear Undo/Redo History 

Deletes the undo/redo information, as a way to reduce memory consumption. 

Remove Hooks (Experimental) 

Analyses the stroke ends in a current drawing and truncates unwanted small 

hooks. 

Switch Cursor  

When enabled, cursor is rendered in software and cursor icons will not be 

displayed. When disabled, cursor is rendered using OpenGL. If you find that the 

cursor is lagging, enabling this may help. It is disabled by default. 

New Colouring Mode  

When enabled, limits the Self Layer Paint Tool to only apply colour in self layer or 

single layer regions (regions formed from strokes in one layer). When disabled, 

the Self Layer Paint Tool will still apply colour to cross layer regions (regions 

formed from strokes in multiple layers). It is enabled by default. 

Use TabletPC (Experimental) 

Allows CACANi to obtain pressure information from devices that uses Microsoft 

Ink. It is disabled by default. 

 

 

Help Menu 

 

About  

Shows information about the CACANi software. 

Subscription 

Allows you to manage your subscription. You can view subscription 
information, extend subscription with a new product key or deactivate the 
subscription to transfer to another computer. 

View Production Information  

Shows information about the currently opened CACANi file. Information can 
be exported as a text file.
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CHAPTER 04 – Drawing Key Frames 

 

 

04 
Drawing Key Frames 
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The Tools Panel 

Making animation drawings is the focus of CACANi. Because of that, we have designed 

tools that will help make the process of animation faster. These are organized in the 

Tools Panel for ease of use and customizability.  

Common Tool Properties 

There are a number of tools which share similar property controls. For example, the 

Drawing Tool shares many similar properties with the Curve and Bezier Tools. As such, 

we’ll have a more thorough explanation when the property is first listed, while 

subsequent similar properties will only make references to these descriptions. 

 

Drawing Tools 

Of all the tools, the Drawing Tools are probably the most frequently accessed.  These 

are used for the creating of your drawings in CACANi.  

 

 

 

 

 

 

Cling Shortcut Keys 

Clinging is a method that forces strokes to snap to each other, while drawing or editing 

strokes. 

When using the Drawing, Single Curve, Curve and Bezier Tools to draw, or the Stroke 

Editor to edit strokes, you can Hold Down CTRL to toggle both Cling to Stroke End and 

Cling to Stroke.  

Alternatively, you can Hold Down SHIFT to toggle Cling to Stroke End only. 

Both shortcut keys, when held down, SWITCH the mode of the Cling functions. For 

example, when Cling to Stroke End is Disabled in the Drawing Controls Bar, holding 

down SHIFT will Enable the function. 

In addition, note that the Invisible Gaps and Auto Cling features (Drawing Tool) will 

only work when Cling to Stroke and/or Cling to Stroke End modes are enabled.  

Please see Chapter 04 – Cling to Stroke End for more information on its uses.  

Single Curve Tool 

Bezier Tool 

Polygon Tool 

Segment Eraser 

Tool 

 

Drawing Tool 

Curve Tool 

Ellipse Tool 

Eraser Tool 
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Handling Sharp Angles in Strokes 

When a drawing is going to be automatically in-betweened, care must be 

taken in areas of the drawing where the strokes have sharp angles. It is 

recommended to use a separate stroke for each side of the angle. This will 

allow a better in-between result.   

See Chapter 08 – In-betweening Sharp Angles. 

 

Drawing Tool 

Allows you to draw strokes freely on the canvas. With a pressure sensitive stylus, you 

will also be able to create strokes of variable width. 

Drawing can be done either using a tablet or the mouse. To draw using the mouse, 

press down the left mouse button and drag to form a path. A stroke will be created 

from the path and the stroke will have a constant stroke width.  

 

 

 

To draw using the tablet, press the stylus down on the tablet to begin. As with the 

mouse, drag the stylus in this manner to form a path and lift the stylus to end the 

stroke. Using the pressure-based information from the stylus, the curve width will 

vary accordingly for the stroke.  

 

 

After the stroke is created, it will be smoothed according to the Smoothing Property 

in the Property Window. This applies to both strokes drawn using the mouse and the 

stylus. 

  

Drawn with mouse 

Drawn with stylus 
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Drawing Tool Properties 

 

 

 

Size 

You can set the maximum width of a stroke by dragging the slider, or left clicking 

and typing a specific value. 

 

Min. Width 

You can set a stroke’s minimum width by dragging the slider, or left clicking and 

typing a specific value. 

 

Opacity 

You can set the opacity / transparency of the stroke by dragging the slider, or left 

clicking and typing a specific value. 

Opacity of the curve to be drawn is set by dragging the slider or left clicking and 

typing a specific value. The higher the value, the less transparent the curve will 

appear. 

 

1 2 3 4 5 6 7 8 

1 

9 

Strokes at different 

opacity values 

Strokes at different 

widths 

Strokes at different 

minimum widths 

2 

3 
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Smoothing 

You can change the smoothness of the stroke by dragging the slider, or left clicking 

and typing a specific value. The larger the value, the smoother the stroke and the 

lesser points there are. 

 

            

 

 

 

Stroke Colour Selection Box 

You can set the stroke colour by [ Left Clicking ] twice to bring up the Colour 

Selection Box dialog box. When done, just [ Left Click ] OK to confirm. 

              

 

Stroke Rendering Modes  

Allows you to draw a stroke with Normal, Invisible or Hidden property. 

Please refer to Chapter 04 – Stroke Rendering Modes.  

Auto Direction (*experimental feature) 

When enabled, CACANi will try to anticipate the stroke direction when matching 

strokes. However, when the matching stroke in the new frame has a difference of 

more than 180 degrees compared to the stroke in the previous frame, it will result 

in an ambiguous stroke direction error message.   

Left Click Twice on Stroke 

Colour Selection Box 

4 

5 

6 

7 
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Invisible Gaps 

With this enabled, when you finish drawing a stroke and the stroke end is near 

another stroke (based on the Cling threshold value), the stroke will be extended 

with an invisible segment to form a connection with the nearby stroke.  

Drawing Modes 

Drawing Modes act like rulers, allowing you to draw straight strokes based on the 

selected mode. 

Normal Drawing Mode 

 Drawing Modes are disabled. 

Grid Drawing Mode 

Strokes are confined to vertical or horizontal straight lines. 

Parallel Drawing Mode 

   Strokes are confined to straight lines at the specified angle. 

Radial Drawing Mode 

   Strokes are confined to straight lines radiating from the Pivot Point. 

Pivot Point 

With this enabled, you can select the Pivot Point on the canvas and move it 

to either adjust the angle of the straight lines in Parallel Drawing Mode, or 

to re-locate the convergent point of the strokes in Radial Drawing Mode.  

 

 

 

 

 

 

 

 

 

  

10 

8 
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Single Curve Tool 

Allows you to draw a stroke, by first dragging from the starting to the ending point, 

then adjusting the curvature with the cursor and keyboard shortcuts.  

            

 

 

While drawing, the curvature can be changed with shortcuts [ [ ] and [ ] ] after 

setting the ending point. 

                       

 

 

Single Curve Tool Properties 

 

 

 

Width 

Sets the maximum width of a stroke. 

 

 

 

 

 

1 2 3 4 5 6 

Drag to ending point 

and left click 

Hover to adjust stroke Left click again to 

confirm stroke 

Decrease Curvature [ [ ] Increase Curvature [ ] ] 

1 
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Curvature 

You can set the curvature of the stroke by dragging the slider, or left clicking and 

typing a specific value.  

                       

 

 

Opacity 

Sets the opacity / transparency of a stroke. 

Points 

Sets the number of data points on the stroke. With more data points, refined 

adjustments to the stroke can be made, but it can also be too time-consuming.  

 

 

 

Stroke Colour Selection Box 

Sets the colour of the strokes being drawn. 

Stroke Rendering Modes 

Allows you to draw a stroke with Normal, Invisible or Hidden property. 

Please refer to Chapter 04 – Stroke Rendering Modes. 

 

 

 

 

Curvature at 0 Curvature at 100 

2 points 7 points 30 points 

2 

3 

4 

5 

6 
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Curve Tool 

Allows you to draw a smooth stroke by creating a sequence of points. Left Click on the 

canvas to create points for the stroke, and Right Click to end the stroke.   

    

 

 

Curve Tool Properties 

Please refer to Chapter 05 - Single Curve Tool Properties. 

 

 

Bezier Tool 

Allows you to draw a discontinuous stroke by creating a sequence of points. Straight, 

discontinuous segments are created when Left Clicking only, while holding down Left 

Mouse Button and Dragging will create curved stroke segments.   

   

 

 

Bezier Tool Properties 

Please refer to Chapter 05 - Single Curve Tool Properties. 

 

 

 

 

 

Left clicking only Hold Left Mouse Button 

and Drag 

Create a series of points Stroke drawn based on 

points 
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Ellipse Tool 

Allows you to draw an ellipse or circle. Dragging the cursor will create an oval shape. 

To create a circle, hold down [Ctrl] while dragging. 

     

 

 

 

Ellipse Tool Properties 

  

 

 

 

Width 

Sets the maximum width of a stroke. 

Opacity 

Sets the opacity / transparency of a stroke. 

Fixed Dimension 

When enabled, all newly created polygons will be the same pixel width and height 

as stated in the W and H input fields.  

W and H (Resizing) 

Width and Height of the ellipse, in pixels. Both values can be changed by dragging 

the slider, or left clicking and typing a specific value. 

Maintain Aspect Ratio 

When enabled, changing either the width or height of the ellipse will lead to a 

corresponding change in the other.  

 

 

 

 

Ctrl + Drag 

1 2 3 4 

5 

6 7 8 

Normal Drag 

1 

2 

3 

4 
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Start From Center 

When enabled, the creation of an ellipse will always start from the center. 

      

   

 

Stroke Colour Selection Box 

Sets the colour of the strokes being drawn. 

Stroke Rendering Modes 

Allows you to draw an ellipse with Normal, Invisible or Hidden Strokes. 

Please refer to Chapter 05 – Stroke Rendering Modes. 

 

 

Polygon Tool 

Allows you to draw a polygon. Dragging the cursor will create a polygon. To create 

regular polygons, hold down [Ctrl] while dragging. 

    

 

 

Polygon Tool Properties 

 

 

 

Width 

Sets the maximum width of a stroke. 

Ctrl + Drag 

1 2 3 4 

5 

6 7 8 

Normal [Start from Center] enabled 

Normal Drag 

6 

7 

8 

1 
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Opacity 

Sets the opacity / transparency of a stroke. 

Fixed Dimension 

When enabled, all newly created polygons will be the same pixel width and height 

as stated in the W and H input fields.  

W and H (Resizing) 

Width and Height of the polygon, in pixels. Both values can be changed by 

dragging the slider, or left clicking and typing a specific value. 

Maintain Aspect Ratio 

When enabled, changing either the width or height of the polygon will lead to a 

corresponding change in the other dimension.  

No. of Sides 

You can create polygons with different number of sides by changing the value in 

the spin box.  

 

Stroke Colour Selection 

Sets the colour of the strokes being drawn. 

Stroke Rendering Modes 

Allows you to draw a polygon with Normal, Invisible or Hidden Strokes. 

Please refer to Chapter 05 – Stroke Rendering Modes. 

 

 

Eraser Tool 

Allows you to erase strokes by dragging over them. 

   

 

  

2 

3 

4 

5 

6 

7 
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Eraser Tool Properties 

 

 

Size 

By changing the width of the Eraser Tool, the erasing area will be larger. 

Round Ends 

When enabled, the ends of the erased stroke segments will be rounded.  

   

 

Erase From Ends 

When enabled, strokes can only be erased from their ends. 

   

 

 

Segment Eraser Tool 

Allows you to erase stroke segments between intersection points. 

   

 

Stroke Eraser Tool  

Allows you to erase the entire stroke.  

 

1 2 3 

1 

2 

3 
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Canvas Navigating Tools 

Canvas Magnifier Tool [ Ctrl + Spacebar + Drag ] or [ 1 ] and [ 2 ] 

Allows you to zoom into the canvas by dragging Right, and zoom out by dragging Left. 

                      

 

 

 

Canvas Pan Tool [ Spacebar + Drag ] 

Allows you to move the canvas by dragging. 

   

 

 

 

Canvas Rotate Tool [ SHIFT + Spacebar ] or [ 3 ] and [ 4 ] 

Allows you to rotate the canvas by dragging in a clockwise, or anti-clockwise motion. 
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Configuration Tools  

Camera Tool 

Allows you to adjust various camera settings in the property bar. When the tool is 

selected, the camera frame is outlined in red on the canvas, with adjustment handles.  

         

Resizing, Rotating, Moving the Camera on the Canvas 

To Resize the camera, left click and drag on any of the 8 handles.  

If the Maintain Aspect Ratio option is enabled (in Property bar), dragging on 

any of the 4 corner handles will resize the camera frame proportionally. 

Alternatively you can also hold down SHIFT while dragging the corner handles 

To Rotate the camera, left click and drag anywhere along the edge of the camera 

frame.  

To Move the camera, left click anywhere within the camera frame and drag. 

Note that the steps described above are applicable for the reference image and offpeg 

image adjustments as well. 

 

The centre of the camera is indicated by a red cross. 

 

The centre of the canvas is indicated by a green cross. 
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Camera Tool Properties 

 

 

   

 

Resizing Anchor 

Sets the anchor for the scaling of selected elements.  

Width and Height 

Resolution of the camera frame, in pixels. Both values can be changed by dragging 

the slider, or left clicking and typing a specific value. 

Maintain Aspect Ratio 

When enabled, changing either the width or height of the camera will lead to a 

corresponding change in the other dimension.  

X and Y (Translation) 

Horizontal and Vertical positions of the centre of the camera frame. A positive X 

value moves the camera frame right, whereas a positive Y value moves the 

camera frame up. 

Angle (Rotation) 

Rotation angle of the camera frame. A positive value rotates the camera frame in 

the clockwise direction, whereas a negative value rotates the camera frame in the 

anti-clockwise direction. 

Apply to All Frames 

When enabled, changes to the camera properties will affect all frames in the layer.  

Reset 

The translation, scaling and rotation values of the camera frame are reverted to 

their original values. 
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Offpeg Tool  

Allows you to adjust offpeg image settings in the property bar.  When the tool and a 

offpeg image are both selected (in property bar or Lightbox), the offpeg image is 

outlined in turquoise on the canvas, with adjustment handles. 

 

Resizing, Rotating, Moving the Offpeg Image on the Canvas 

Refer to Camera Tool > Resizing, Rotating, Move the Camera on the Canvas. 

 

Offpeg Tool Properties 

 

 

 

X and Y (Translation) 

Horizontal and Vertical positions of the centre of the offpeg image, in pixels. A 

positive X value moves the image right, whereas a positive Y value moves the 

image frame up. 

W and H (Resizing) 

Width and Height of the offpeg image, in pixels. Both values can be changed by 

dragging the slider, or left clicking and typing a specific value. 

Angle (Rotation) 

Rotation angle of the offpeg image. A positive value rotates the image in the 

clockwise direction, whereas a negative value rotates the image in the anti-

clockwise direction. 

Reset 

The translation, scaling and rotation values of the offpeg image are reverted to 

their original values.  
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Stroke Rendering Modes 

To make hand drawn animation convincing, 3 dimensional movements like turning 

and rotation are frequently employed. As a result, the features of an object or 

character are always changing, appearing and disappearing in animation sequences. 

To help with this aspect of animation production, we have introduced the concept of 

Stroke Rendering Modes and Colour Separation Modes in CACANi. Strokes or 

segments of strokes can be rendered invisible or hidden so that they do not show up 

on the exported images.  

 

 

 

Normal Stroke Rendering Mode 

Strokes drawn are displayed on the canvas and can be exported. They can form closed 

regions. 

 

 

Invisible Stroke Rendering Mode 

Strokes drawn are displayed as pink paths on the canvas and cannot be exported. 

Invisible strokes or stroke segments cannot be seen, but they can still form closed 

regions.  
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Hidden Stroke Rendering Mode 

Strokes drawn are displayed as purple paths on the canvas and will not be exported. 

Hidden strokes or stroke segments cannot be seen and cannot form closed regions. 

 

 

 

Colour Separation Modes 

In addition to the 3 stroke rendering modes mentioned above, we have another 6 

colour separation modes to allow you to draw colour separation strokes.  
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Understanding Colour Separation Strokes 

These are strokes that you can use to draw regions like highlights or shaded regions 

of an object or character. These strokes can be turned off (via the Colour Separation 

Display Mode) and will not appear in the final export of the drawings. 

 

 

 

 

 

 

 

 

Colour Separation Modes VS Colour Separation Layers 

The main difference lies in that when using Colour Separation Modes, the strokes are 

within the same layer as the normal visible strokes. In addition, the Bone Tool can be 

used to group them together with the normal strokes. 

The Colour Separation Layers are discrete layers, so ALL strokes within are colour 

separation strokes. However, that means that these strokes cannot be grouped with 

strokes in other layers.  

  

No Colour Separation 

Strokes drawn 

Colour Separation 

Display Mode 

Enabled 

Colour Separation 

Display Mode 

Disabled 
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Drawing Controls 

The Drawing Controls holds the drawing mode options and the Undo and Redo tools. 

The drawing mode options, when enabled, affect the drawing and selection of strokes 

in different ways, so it is best for the artist to learn and be familiar with their usages 

in different scenarios.  

 
    

Cling to Stroke End Mode 

  When enabled, the cursor will snap to the nearest stroke end. 

   

 

Cling to Stroke Mode 

  When enabled, the cursor will snap to the nearest stroke. 

   

 

Cling Range 

   

You can adjust the range (based on screen pixels) at which the clinging will come into 

effect. Note that at higher zoom levels, the perceived range will be smaller.  

Clinging is an important method to ensure the strokes form closed regions for 

painting later. 

Please see Chapter 05 – Cling Shortcut Keys for more information on its uses.  
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Cross-Layer Stroke Selection Mode 

  When enabled, you can select strokes in different layers. 

    

 

 

 

New Stroke Index Mode 

When enabled, any unmatched strokes will be disregarded, and strokes drawn will be 

assigned new stroke index numbers. This is needed when drawing new elements that 

are not in the previous key frame, and unmatched strokes exist in the current frame. 

In the example below, one star moves out of the canvas at Frame 7, and a second star 

appears from Frame 8 to Frame 13. Without enabling the New Stroke Index Mode, 

CACANi will keep prompting you to draw the first star in Frames 8 – 13. 

            

              

 

 

 

 

Disabled: Only strokes in 

active layer are selected 

Enabled: Strokes in all layers 

(within cel) are selected 

Frame 1 

Frame 7 

Frame 8 

Frame 13 
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To draw the above example, 10 strokes are drawn for the first star in the first 2 key 

frames, and then 5 in-between frames are generated. 

  

 

Moving to the empty third key frame (Frame 8), CACANi will prompt you to draw the 

matching strokes.  

 
  

 

However, from Frame 8 onwards, since the star has disappeared from the canvas, we 

do not need to draw the star anymore. 

Hence, to skip the drawing of the first star, enable New Stroke Index Mode. This will 

instruct CACANi to disregard the matching strokes in the previous frame, and allow 

you to draw new strokes, which in this case, is the second, smaller star.  

  

 

 

 

 

Frame 1 

Frame 7 
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Now, from Frame 9 onwards, you will not be prompted to match those strokes 

anymore.  

 

 

However, if you need to draw the first star again in subsequent frames, that can be 

done by changing the Reference Frame to display Frame 1’s Onionskin Image.  

Please refer to Chapter 08 – Lightbox Panel: Reference Frame. 

 

Auto Stroke Grouping Mode 

  When enabled, every stroke drawn will be grouped individually. 

 

Undo Previous Action 

When enabled, the previous action will be undone. You can undo up to a maximum 

of 30 actions. 

 

Redo Next Action 

When enabled, the next action will be redone. You can redo up to a maximum of 30 

actions. 
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CHAPTER 05 – Selecting & Editing Strokes 

 

 

05 
Selecting & Editing 

Strokes 
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Refining your Drawings in CACANi 

With CACANi’s paperless workflow, we have created tools that will help you produce 

animation drawings of utmost finesse. From stroke selection to gap closing to 

segment hiding, these editing tools will allow you to prepare the sequence for 

colouring. 

Common Tool Properties 

There are a number of tools which share similar property controls. As such, we’ll have 

a more thorough explanation when the property is first listed, while subsequent 

similar properties will only make references to these descriptions. 

Editing Tools 

The Editing Tools are used for stroke and reference image selection and adjustments.  

       

 

Selection Tool 

Allows you to make selections and adjust strokes, groups, and reference images on 

the canvas. Selection is done by left clicking on the element, or dragging a selection 

box to select multiple elements.  

Hold down [Shift] to select multiple elements. Hold down [Alt] to deselect elements. 

Once an element is selected, its bounding box will appear. 

 

To move selected elements, left click on one of the elements and drag to the desired 

location. Left clicking on the canvas, either within or outside of the bounding box, 

clears the selection. 

To resize selected elements, left click and drag on one of the bounding box handles. 

To resize elements proportionally, hold down [SHIFT] while left clicking and dragging 

the handles.  

Stroke Editor Selection Tool 
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To rotate selected elements, left click and drag the green circular handle in a 

clockwise or anti-clockwise motion. The elements will be rotated with respect to the 

pivot (small red circle). If you want to change the centre of rotation, left click and drag 

the pivot to the desired position before rotating.  

 

Selection Tool Properties 

 

 

 

 

Selection Modes 

Allows you to select strokes using Line Selection, Region Selection or Rectangular 

Selection Modes. 

Line Selection Mode 

Allows you to select strokes by moving your cursor over the strokes. 

Region Selection Mode 

Allows you to select strokes by forming a freeform region around the strokes. 

Strokes that are partially within the region are also selected. 

Rectangular Selection Mode 

Allows you to select strokes by forming a rectangular region around the 

strokes. Strokes that are partially within the region are also selected. 

Apply to Coloured Regions 

When enabled, coloured regions will be updated whenever strokes are moved, 

scaled or rotated.  

Size 

Sets the maximum width of selected strokes. 

Opacity 

Sets the opacity / transparency of selected strokes. 

Resizing Anchor 

Sets the anchor for the Resizing of selected elements.  

W and H (Resizing) 

Width and Height of the selected elements, in pixels. Both values can be changed 

by dragging the slider, or left clicking and typing a specific value. 
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Maintain Aspect Ratio 

When enabled, changing either the width or height of selected elements will lead 

to a corresponding change in the other.  

X and Y (Translation) 

Horizontal and Vertical positions of the centre of the selected elements. A positive 

X value SHIFTs the elements right, whereas a positive Y value SHIFTs the elements 

up. 

Angle (Rotation) 

Rotation angle of the selected elements. A positive value rotates the elements in 

the clockwise direction, whereas a negative value rotates the elements in the anti-

clockwise direction.  

 

Reference Images 

The Selection Tool is also used to adjust and unload reference images.  

Loading / Unloading Reference Images 

(Refer to Loading Reference Images on how to load external images) 

To unload an image, the Reference Layer in the Cel Bank must be active. Then use 

the Selection Tool to click on the reference image on the canvas. It will be outlined 

in red. Right Click to bring up the Context Menu, then select Remove Selected 

Images. 

 

Resizing, Rotating, Moving the Reference Image on the Canvas 

To adjust a reference image, the Reference Layer in the Cel Bank must be active. 

Then use the Selection Tool to click on the reference image on the canvas. It will 

be outlined in red, with adjustment handles.  

To select multiple reference images, hold down SHIFT and left click on each of the 

reference images. Alternatively, left click and drag the cursor over the reference 

images to select them.    

 

9 

8 

7 
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To Resize the reference image(s), left click and drag on any of the 8 handles.  

If the Maintain Aspect Ratio option is enabled (in Property bar), dragging on 

any of the 4 corner handles will resize the reference image proportionally. 

Alternatively you can also hold down SHIFT while dragging the corner handles 

To Rotate the reference image(s), left click and drag anywhere along the edge of 

the image.  

To Move the reference image(s), left click anywhere within the image and drag. 

 

Reference Image Tool Properties 

When a reference image is selected, the Selection Tool properties will have 

different options. 

 

 

 

 

X and Y (Translation) 

Horizontal and Vertical positions of the centre of the reference image, in 

pixels. A positive X value moves the image right, whereas a positive Y value 

moves the image frame up. 

W and H (Scaling) 

Width and Height of the reference image, in pixels. Both values can be 

changed by dragging the slider, or left clicking and typing a specific value. 

Maintain Aspect Ratio 

When enabled, changing either the width or height of the reference image 

will lead to a corresponding change in the other dimension. 

Angle (Rotation) 

Rotation angle of the reference image. A positive value rotates the image in 

the clockwise direction, whereas a negative value rotates the image in the 

anti-clockwise direction. 

Reset 

The translation, scaling and rotation values of the reference image are 

reverted to their original values.  
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All Frames 

When enabled, changes to the reference image properties will affect the 

reference images in all the frames in the layer. 

  

6 
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Stroke Editor 

Allows you to edit data points on a stroke to adjust its path. This is done by first move 

the cursor over the stroke to highlight it. To change the path of a stroke, Left Click and 

Drag on a data point.  

    

 

To add a data point, left click on any part of the stroke that does not already have a 

data point. A new data point will be created.   

   

To remove a data point, hold down [ALT] and Left Click on any existing data point. 

The selected data point will be removed.  

 

Stroke Editor Context Menu 

Alternatively, you can access stroke editing options via the context menu.  

Hover over any part of the stroke without a data point and Right Click to bring up the 

context menu. Select Add Point to create a new data point. 

 

 

To remove data points, hover over a data point and right click to bring up the context 

menu.  
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For removal of data points, there are 2 options in the context menu: Remove Point 

(reinterpolate) and Remove Point (subdivide). The difference is that the former 

option adjusts the whole stroke to make it smoother, while the latter changes only 

the segment where the data point was removed.  

 

 

A stroke can also be separated into 2 strokes by selecting the Break option from the 

context menu. This option can be found in both the Add and Remove Point context 

menus.  

 

 

 

Stroke Editor Properties 

 

 

 

Stroke Edit Modes 

When adjusting strokes with Smooth Edit mode selected, smoothness within the 

segments of a stroke is maintained. You can adjust the path of the stroke by left 

clicking and dragging the data points (green points) and end points (red and blue 

1 2 

Remove Point (reinterpolate) 

Original stroke 

Remove Point (subdivide) 

3 
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point). The selected stroke will be highlighted in red, and the selected point will 

be displayed as an orange dot.  

    

 

When adjusting strokes with Control Point Edit mode selected, segments of a 

stroke can be either continuous or discontinuous. The control points (purple 

points) of a selected data point and its adjacent data points are displayed. When 

editing, only the segment around the selected data point will be affected. 

   

 

 

 

 

 

 

To create sharp corners in the stroke, hold down [Ctrl] while dragging the 

control points. The stroke is now discontinuous. 

   

 

After the stroke is made discontinuous, the sharp corner will be maintained, 

even when moving the point.  

When moving data points, stroke path is continuous. 
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However, moving a control point for a sharp corner will cause the 

discontinuous segment to be automatically re-adjusted into a continuous 

segment.  

   

 

To maintain the sharp corner while moving the control point, hold down [Ctrl] 

while dragging. 

 

 

 

 

 

When Fixed Ends mode is selected, only the 2 end points of a stroke can be 

selected. When you select and drag one end point, the other end point will be 

fixed and will act like a pivot. The stroke then can be rotated or resized according 

to this pivot. 
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Influence 

Controls how many adjacent points are affected by a data point adjustment in the 

stroke. With a higher influence, the movement of adjacent points will become 

larger. At 0% influence, the adjacent data points are not affected. 

 

   

Lock Stroke 

When enabled, a stroke remains selected during the editing of its points, or when 

the cursor hovers away from it.  

 

 

 

 

  

Influence 10% 

Influence 0% 
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Animation Editing Tools 

The Animation Editing Tools are used when you need to adjust the generated strokes 

in the in-between frames.  

 

 

Feature Point Tool 

Allows you to adjust the deformation of a generated stroke in an in-between frame. 

Please see Chapter 08 – Using the Feature Point Tool for more information. 

Feature Point Tool Properties 

 

Remove All Feature Points 

Allows you to clear all feature points on the selected stroke.  

 

Bone Tool 

Allows you to change the way strokes are generated in a group in an in-between frame. 

Please see Chapter 08 – Using the Bone Tool for more information. 

 

Bone Tool Properties 

 

 

 

Remove Bone 

Allows you to clear the paths for the selected stroke group. 

Points 

Defines the number of points present on the created path.  

Maintain Bone Length 

When enabled, the paths for a stroke group will be constrained by the length of 

the drawn bones in the key frames. 

Feature Point 

Tool 

Bone Tool 
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Stroke Edit Modes 

Allows you to edit data points on a stroke to adjust the paths of the stroke groups. 

Please see Chapter 05 – Stroke Editor Properties – Stroke Edit Modes for more 

information. 

Lock Path 

When enabled, the path is kept selected and can be edited more easily.  

Bone Rotation Paths 

Allows you to change how the paths are generated based on the angle of rotation. 

Set Path Small Rotation 

The in-between frames for the stroke group are generated based on an angle 

of rotation less than 180°.  

     

Set Path Middle Rotation 

The in-between frames for the stroke group are generated based on an angle 

of rotation larger than 180° but smaller than 360°.  

     

Set Path Large Rotation 

The in-between frames for the stroke group are generated based on an angle 

of rotation larger than 360° but smaller than 540°. 

     

4 
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Segment Editing Tools 

The Segment Editing Tools are used for cleaning up and adjusting the look of the 

strokes. They are also very important for ensuring that the drawings are ready for 

painting. However, the tools do not affect the curvature of the strokes. 

 

 

Segment Tool 

Allows you to alter the visibility of sections of a stroke, where the sections are created 

by intersections with other strokes.  

    

 

 

Free Segment Tool 

Allows you to alter the visibility of sections of a stroke, regardless of any intersections 

with other strokes.  

    

 

Free Segment Tool 

Stroke Width Tool 

Segment Tool 

Clean up Tool 
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Clean Up Tool 

Allows you to edit how strokes are attached to each other to form closed regions for 

painting. The Clean Up Tool can perform 3 different functions, depending on the 

proximity of the strokes. 

Gap Closing 

At least 1 stroke end must be within the selected region for the tool to work. 

   

 

 

Artifact Removal 

Allows you to remove stroke artifacts, or unwanted stray ends, during the drawing 

process. Stroke artifacts falling within the threshold region are removed.  

           

 

 

Hidden Segment Cleanup 

Allows you to convert hidden segments back to visible segments, without having to 

switch to the Segment or Free Segment Tools. This is helpful when regions are not 

closed due to hidden segments. 

         

 

 

 



User Manual 

88 | P a g e  

 

Clean Up Modes 

You can switch between different Clean Up modes in the tool. The Combined Mode 

allows you to perform the above 3 functions at once. However, depending on the 

complexity and proximity of the selected strokes, results will vary. 

              

 

The other 2 modes, Gap Close Only and Artifact Removal Only, as their names suggest, 

limits the Clean Up Tool to only perform gap closing operations or artifact removing 

only operations respectively. This can help with certain situations where there are 

many intersecting strokes. 

 

Clean Up Tool Properties 

 

 

 

Clean Up Modes 

Allows you to specify whether the tool works in Combined, Gap Close Only or 

Artifact Removal Only Mode. 

Size (Apply to All Strokes only) 

Sets the gap close or artifact removal threshold region for the Apply to All Strokes 

option. A larger value results in wider stroke gaps closed or longer stroke artifacts 

removed.  

Apply to All Strokes  

Allows you to close all stroke gaps and artifacts in the drawing that are within the 

region defined in the Size property. However, some strokes may be altered in an 

undesirable way.  
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Keep Gaps Invisible 

When enabled, any gaps closed using the Clean Up Tool are performed with 

invisible strokes so that the strokes do not appear to be altered. 

    

 

Extensions Only Mode (Gap closing)  

When disabled, stroke ends within the threshold will be extended to connect to 

each other, regardless of the strokes’ directions. 

        

 

When enabled, the stroke ends will be extended and connected to each other.  

    

 

 

With the Extension Only Mode, using different threshold sizes will result in 

different stroke extensions, as the circumference of the threshold determines 

where the connection point is. 

                  

 

4 
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Stroke Width Tool 

Allows you to change the stroke width at different segments of a stroke. You can 

adjust the stroke width by left clicking on any of the data points or endpoints, and 

dragging the mouse left (decrease stroke width) or right (increase stroke width). 

                  

 

 

Stroke Width Tool Properties 

 

 

 

Width 

Sets the maximum width of selected strokes. 

Range 

Sets the number of adjacent data points that are affected by the stroke width 

change. Note that after the width adjustment, you will also need to move the data 

point slightly with the Stroke Editor to get a smooth width transition. 
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CHAPTER 06 – Using Display Tools 

 

 

06 
Using Display Tools 
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Displaying Information on the Canvas 

 

While drawing, animators frequently need to see information about their drawings, 

from camera frames to measurement grid and stroke gaps. However, it can be very 

messy when all the information are switched on at the same time. In CACANi, these 

display modes are arranged at the top of the interface so that they can be activated 

when needed.  

 

Display Property Bar 

  The Display Property Bar is divided into a few sections. 

 

 

 

  

 

Canvas Display Modes 

Camera  

When enabled, it allows you to see the camera frame on the canvas. The camera 
boundary is shown as a red rectangle, while the video safe frame is in blue. 

Grid / Field Chart 

Allows you to display a rectangular grid and/or field chart over the canvas. This will 

help with the planning and layout of drawings within the canvas. 

 

 

Region Display Modes Stroke Display Modes Region Display Modes 
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Stroke Display Modes 

Stroke Width 

When enabled, the actual stroke width is displayed. When disabled, the Stroke 
Skeleton is shown, for more accurate drawing. In addition, the stroke skeleton can be 
thickened using the Stroke Skeleton slider for easier viewing. 

 

 

 

Stroke Direction  

When enabled, strokes selected with the Selection tool will have arrows displayed on 
them. These arrows indicate the direction in which the stroke was drawn and will 
allow you to draw matching strokes in subsequent frames correctly.  

Invisible and Hidden Strokes  

When enabled, invisible and hidden strokes will be displayed in the canvas in pink and 
purple respectively.  

Fade Non-Active Layers  

When enabled, strokes on unselected layers will be faded out. By only showing 
specific sections of a drawing, this can help you to focus on those areas and not be 
confused.  

Grey out Matched Strokes (Navigator only)  

(Only applicable to Navigator Panel, Reference Frame turned on) When enabled, 
strokes that are already matched or corresponded will be displayed as grey strokes, 
instead of the strokes’ original colour. This can help you to identify the remaining 
strokes to match.  

Please see Chapter 08 – Grey Out Matched Strokes Display Mode. 

 

 

 



User Manual 

94 | P a g e  

 

 

Stroke Gaps  

When enabled, stroke ends which are not connected to any other stroke will be 
indicated with a light orange circle. 

Switch Hidden Stroke View 

When enabled, normal strokes will be faded out while invisible and hidden strokes 

will be displayed clearly to allow you to draw the strokes easily. 

Colour Separation Strokes  

When enabled, strokes selected with the Selection tool will have arrows displayed on 
them. These arrows indicate the direction in which the stroke was drawn and will 
allow you to draw matching strokes in subsequent frames correctly.  

Toggle Lightbox Display 

When enabled, drawings on previous or subsequent frames are displayed on the 
canvas as onionskinned images. For configuration of onionskinned images, you can 
use the Lightbox Settings Panel.  
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Region Display Modes 

Hide Region Colours 

When enabled, no region colours are displayed.   

 

 
 

Show Region Colours 

When enabled, filled regions will be displayed in their original 
colours.   

 

 

Highlight Self Regions 

When enabled, all self-layer regions will be displayed with 
checkered patterns. 

 

 

Show Closed Regions 

When enabled, all regions that are closed and do not have any gaps 
will be painted in alternating colours. This is useful when you want 
to check for gaps before painting the regions.  

 

Show Closed Self Regions 

When enabled, all self-layer regions that are closed and do not 
have any gaps will be painted in alternating colours with checkered 
patterns. 

 

Show Painted Regions 

When enabled, all regions that have been filled with colour will be 
painted in black. This is useful when you need to verify that you 
have not missed any regions that require painting.  

 

Please refer to Chapter 10 - Cross Layer and Self-Layer Regions for more information 
on regions. 
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CHAPTER 07 – CACANi Cel System 

 

 

07 
CACANi Cel System 
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The Cel System 

 

 

 

 

 

The Cel System is used for the management of layers and frames for animation. Cels, 
Layers and different types of frames can be added or removed, their orders changed 
and management for drawing and animation.  

Cel Selection Bar 

Allows you to access cels and adjust various cel-related settings easily. 

Layer Selection Bar 

Allows you to access layers and adjust various layer-related settings easily. 

Frame Controls 

Allows you to create or remove cels, layers or frames. 

Cel Bank 

Allows you to perform all cel, layer and frame operations. 

  

Cel Selection Bar 

Frame Control Cel Bank 

Layer Selection Bar 
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Cel Bank 

 

In CACANi, the Cel Bank is the main location for frames, layers and cels creation and 
editing, while the Cel / Layer Selection Bars and Cel Control Bar provide 
supplementary support.  

While the Cel Bank is a panel that can be moved around, docked or hidden from view, 
the Cel Selection Bar, Layer Selection Bar and Cel Control Bar are fixed on the user 
interface for ease of use. 

 

Sections of the Cel Bank 

 

The Cel Bank consists of 2 distinct components, the Cel View section and the Frame 
View section. 

The Cel View shows the cel / layer names and allows you to perform cel / layer 
operations, while the Frame View shows the frames and contains the frame 
operations.  

  

Cel View Frame View 
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Cel View 

 

 

                              

 

 

Elapsed Time 

Shows the time at the active frame, in ( Minutes : Seconds : Frames ) format.  

Active Layer 

Lists the current selected cel or layer.  

Key frame only Onionskins 

When enabled, the Lightbox will only show key frames as onionskin images. 

Expand / Collapse Cel View 

Reveals or hides the layers within a cel. 

Colour Tag 

Displays the colour tag of a layer.  

Opacity Slider 

Allows you to adjust the opacity level of a cel or layer. 

Layer Name 

Displays the cel or layer. 

Layer Visibility 

When enabled, the contents of the layer are displayed. 

Layer Lock 

When enabled, the strokes in the layer are locked and cannot be changed.  

 

 

Key frame only Onionskins 

 

Expand / Collapse Cel 

View 

Active Layer Elapsed Time 

Layer Visibility 

Layer Lock 

Layer Lightbox 

Layer Tag 

Opacity Slider Layer Name 

Cel View Scrollbar 
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Layer Lightbox 

When enabled, the strokes in the layer are included when displaying the frame as 

an onionskin image. 

Cel View Scrollbar 

Allows you to pan vertically through the created cels and layers. 

 

 

Frame View 

 

 

        

 

 

Frame View Scrollbar 

Allows you to pan horizontally through frames and sheets. 

Offpeg Onionskin Marker 

When enabled, an onionskin image of the current frame is displayed on the canvas, 

independent of the active frame. 

Playback Range 

Indicates the frames that will be played back when the Playback Range checkbox 

is ticked in the Playback Bar. 

Range ‘In’ Point 

Allows you to adjust the starting frame of the Playback Range. 

Range ‘Out’ Point 

Allows you to adjust the ending frame of the Playback Range. 

Onionskin Marker 

When enabled, an onionskin image of the current frame is displayed on the canvas. 

Unlike the Offpeg Onionskin, this is always in relation to the active frame. 

 

Frame View Scrollbar 

Range ‘In’ Point 

Onionskin Marker 

Range ‘Out’ Point 

Playback Range Offpeg Onionskin Marker 

Cel Frame Number 

Frame Number 

Active Frame 

Playhead 
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Playhead 

Indicates the location of the active frame. You can drag the Playhead to make 

another frame active. 

Active Frame 

Indicates the current selected frame in the cel bank. 

Frame Number 

Indicates the frame number of the overall animation sequence. 

Cel Frame Number 

Indicates the frame number of the specific cel. 

 

Frames, Layers, Cels 

The distinction between cels, layers and frames is important to the understanding of 

CACANi’s system of animation. With this knowledge, you will be able to make use of 

CACANi’s unique workflow to create your animations quickly.  

 

 

Frames 

A frame can consist of a drawing in a single layer, or be made up of a column of 

drawings in multiple layers. A frame is what you see displayed on the canvas.  

Layers 

A layer is a single sequence, or row, of frames. There are different types of layers 
available, each with its own purpose. Layers within the same cel have the same 
number of frames and frame types. 

Cels 

A cel is a master layer that can hold multiple layers. Cels can have different number 
of frames from each other.  

 

 

  

Layer 

Cel 

Frame 
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Frame Types 

In CACANi, there are 2 types of frames, key frames and in-between frames. 

 

 

 

Key Frames 

Frames that hold drawings created by the animator. They are normally at the 

beginning and ending part of an animation sequence. Key frames are denoted with a 

dash beneath the stroke numbers. 

In-between Frames 

Transition frames that are generated based on the key frames. Information between 

matching strokes in a pair of key frames is used to create in-between frames. In-

between frames do not have any marking beneath the stroke numbers and are 

coloured a darker shade of grey compared to key frames. 

Note that multiple layers within a cel form a frame.  

 

Conversion between Frame Types 

You can turn a key frame into an in-between frame, and vice versa. This can help you 
to perform adjustments on the animation sequence, or as a way to create breakdown 
key frames. 

To perform this action, Right-Click on a frame to bring up the context menu. Since this 
frame is a key frame, select Convert Frame(s) to Tween to convert into an in-between 
frame. 

          

 

However, you have to be extra careful when converting key frames into in-between 
frames, in that you do not accidentally re-generate in-between frames. This may 
cause the strokes in the newly converted in-between frame to change. 

 

Key Frame In-between Frame 
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Layer Types 

There are different types of layers to help you animate in CACANi. Each type is 

coloured differently and has a specific use. You can access them from both the Cel 

Bank and the Layer Selection Bar. 

 

       

 

Drawing Layer 

Most frequently used layer type. You can draw, trace, animate and paint your 

drawings here. 

Sketch Layer 

Used for roughing out your animations. Sketch layers do not have animation 

capabilities. In addition, you cannot paint regions formed by strokes in Sketch layers.   

Reference Layer 

Used for loading external files as reference images. Loaded images can be moved and 
manipulated using the Reference Image Settings. No drawing or animation can be 
done on this layer. 

Colour Separation Layers 

Used for drawing colour separation strokes. When Colour Separation Display Mode 
is turned off, the strokes drawn in these layers do not show up on the canvas or the 
exported images. 

There are a total of 6 different colour separation layers: Red, Green, Blue, Cyan, Pink, 
Yellow. 

Please see Chapter 05 – Colour Separation Strokes for more information. 

 

 

 

Drawing Layer 

Reference Layer 

Colour Separation Layer 

Sketch Layer 
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Using the Cel Bank 

Cel View Interactions 

This is where you can perform layer / cel creation and selection operations, as well as 

amend various layer statuses.  

Layer / Cel Creation 

You can create a new layer by Right-Clicking on a cel, layer, or the empty space below 

the layers and choosing either of the New ... Layers options from the dropdown menu.    

          

 

Layer Name 

You can rename a layer by Left-Clicking Twice on the name. A dialog box will pop up 

and the new name can be entered. 

     

 

Layer Selection 

When working in CACANi, there are various methods you can use to select layers: 

Single Layer  

A single layer can be selected easily by Left-Clicking directly on the specific layer. 

The layer will be highlighted.  

Multiple Layers in Sequential Order 

When you need to select layers arranged in sequence, start by Left-Clicking on 

the first or last layer of the sequence. Then, Hold Down the SHIFT key and Left 

Click to select the layer on the other end of the sequence.  

 

Multiple Layers in Non-sequential Order 
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When you need to select layers arranged arbitrarily, start by Left-Clicking on any 

layer you wish to select it. Next, Hold Down the Ctrl key and Left-Click on another 

layer you wish to include in your selection. 

Layer Types 

As there are different types of layers, you can use Select Similar Layer Types to 

only pick layers that are of the same type as the current active layer. This can be 

used to quickly change layer statuses for multiple layers.  Conversely, you can 

choose Select All Other Layer Types to pick layers that are not of the same type 

as the current active layer. 

 

 

 

 

 

 

Layer Selection - Colour Tags 

In addition to Layer Types, you can also assign Colour Tags to specific layers, so 

that you can select them easily later. All layers are assigned the Orange Tag by 

default. To select layers with the same Colour Tag, you can Right-Click on the 

Orange square on a layer to bring up the dropdown menu, and choose Select 

Similar Colour Tag.  
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To assign a new Colour Tag, first select the required layers (using SHIFT + Left Click or 
Ctrl + Left Click).  

Then, Right-Click on the Orange square on the layer and choose a different Colour Tag 
from the dropdown menu. 

            

 

 

Moving Layers / Cels (Display Order) 

You can adjust the order of the layers or cels so that the contents of a layer are 

displayed above or below the rest. To do so, Left Click and Drag a layer to reposition 

it. A red line will appear to indicate where the new position of the layer will be. 

       

     

 

  

Layer 1 

Layer 2 
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Layer Duplication 

You can clone an active layer by Right-Clicking and choosing Duplicate Active Layer 

from the dropdown menu.  

          

 

 

  However, there is a limitation with layer duplication: 

Motion paths are not duplicated.  

Motion paths have to be redrawn, or manually copied from the previous layer. 

   

 

 

Layer Removal 

You can delete a selected layer or cel by Right-Clicking and choosing Remove Layer 

or Remove Cel from the dropdown menu. In addition, multiple layers or cels can be 

deleted at the same time by using SHIFT + Left Click (for layers / cels arranged in 

sequence) or Ctrl + Left Click (for layers / cels arranged arbitrarily) to select the 

required layers.  
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Layer Opacity Slider 

You can adjust the opacity, or transparency, of a layer via the Layer Opacity Slider. 

Left Click and Drag on the slider to vary the opacity level. 

    

 

 

Layer / Cel Status Toggle 

You can change the status of a layer or cel in the Cel View by enabling / disabling the 

icon directly.  

The Visibility icon displays or hides the contents of the selected layer. 

     

      
 

 

The Lock icon, when toggled, prevents the contents of the selected layer from being 

changed. The cursor icon will change to reflect the locked status of the active layer. 
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The Layer Lightbox icon, when toggled, includes the strokes of the selected layer 

when the frame is displayed as an onionskin image. Note that the onionskin image 

will only be displayed when the Toggle Lightbox option in the Display Bar is enabled 

as well.  

 

    

     

 

To change a similar status for multiple layers / cels at the same, you can first select 

multiple layers / cels (using SHIFT + Left Click Drag or Ctrl + Left Click), then Left Click 

on the relevant status icon for one of the selected layers.  

    

 

Alternatively, you can also perform the same operations by using the dropdown menu 

options: 
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Loading Reference Images 

You can load images into reference layers in a few ways.  

Loading a single image to the Reference Layer 

To load an image file as a reference image, Right-Click on any frame in the Cel 

Bank, then select Load Image(s) from the context menu. 

               

 

Choose an image file from the File Explorer Dialog. A new Reference Layer will be 

created with the selected reference image in the same cel, indicated with a 

diagonal line over the reference sheet. 

   

 

Alternatively, you can start by first creating the reference layer, then Left-Clicking 

Twice on a particular frame to bring up the image loading dialog window. 
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Loading multiple images to the Reference Layer 

Using the same Load Image(s) option or Left-Clicking Twice on a reference layer 

frame, you can also select multiple, non-sequential image files to bring into the 

Cel Bank. 

   

 

Loading an image sequence to the Reference Layer 

Alternatively, you can select Load Image Sequence to load a series of pictures 

numbered sequentially into CACANi.  

 

 

You only need to choose the first file for the sequence. CACANi will warn you that 

it will be increasing the number of created frames and possibly replacing images 

loaded previously. Click OK to continue. 

   

For the above to work correctly, all the files in the image sequence should have 

filenames that end with a numeric value (ie. file001, file002, file003…..). 
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Clearing reference images from the Reference Layer 

To clear a reference image, [ Right-Click ] on the frame in the Cel Bank, then select 

Clear Image from the context menu. The diagonal line indicator will disappear 

from the reference sheet as well. 

   

 

 

To clear multiple reference images that are arranged sequentially, you can use 

Drag + hold down Left Click or SHIFT + hold down Left Click to first select the 

reference sheets, then Right Click and select Clear Image(s) from the context 

menu. 

   

 

 

To clear multiple reference images that are not arranged sequentially, you can 

use Ctrl + hold down Left Click to first select the reference sheets, then Right Click 

and select Clear Image(s) from the context menu. 
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Frame View Interactions 

Using the Playhead 

The playhead shows the location of the active frame. You can scrub through the 

animation sequence by Left Clicking and Dragging the Middle of the playhead. The 

active frame is displayed on the Canvas.  

 

 

 

 

Displaying Onionskin Frames 

In addition, the playhead can be used to display or hide onionskin frames. You can do 

that by Left Clicking and Dragging the Edges of the playhead. The orange dots 

indicates the onionskin frames displayed. 

 

   

   

 

  Left Click and Drag AWAY from the playhead to display onionskin frames.  

Left Click and Drag TOWARDS the playhead to hide onionskin frames. 
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Displaying Offpeg Frames 

The onionskin frames are relative to the playhead and active frame. When the 

playhead is moved, the onionskin frames are changed as well. 

Offpeg frames are a different type of onionskin frames. They do not change when the 

playhead is moved. They can be activated by Left Clicking on the dots above the Frame 

Numbers in Frame View. 

 

       

       

 

  Offpeg Frames can be adjusted via the Offpeg Tool. 

To deactivate the Offpeg Frame, Left Click on the dot again. 

 

 

Setting the Playback Range 

You can set a specific range to be played back with the ‘In’ and ‘Out’ range tabs. Left 

Click and Drag the ‘In’ range tab to the starting frame of your range, and the ‘Out’ 

range tab to the ending frame of your range.  

 

        

Finally, enable the Cycle Animation checkbox to loop the playback. 
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Cel Timing Adjustments 

You can move a cel (and the layers within) forwards or backwards in time so that 
different cels start / stop at different frames. 

 

 

 

Maximising / Minimising a Cel 

Cels can be minimized by Left-Clicking Twice on the cel frames in the cel bank frame 

view. You can maximise the cel again by Left-Clicking Twice on the cel frames. 

               

 

 

Frame Creation Window 

In Frame View, you can create frames via the Frame Creation dialog window. You can 

bring up this window by moving your cursor at the right end of a frame, or in the 

gutter between 2 frames. The cursor icon will change. Left-Click and Drag the cursor 

to the right and the window will pop up.  
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Frame Addition 

The Frame Creation Window allows you to create different types of frame(s) or 

sequences.  

Duplicate Current Frame 

Allows you to create a copy of your selected frames.   

     

 

Add Blank Key Frame(s) 

Allows you to create empty key frames for drawing. 

     

 

Add Blank In-between Frame(s) 

Allows you to create an empty in-between frame for generating in-betweens. 

                           

 

 

Sequence Looping 

Other than adding frames, the Frame Creation Window also allows you to easily 

duplicate a sequence of frames. Instead of selecting a single frame, use SHIFT + Left-

Click to select a series of frames. Enter a numeric value to determine how many times 

the sequence is duplicated. 

Loop 

Allows you to duplicate the selected sequence, with the frames arranged in the 

same sequence. 
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Reverse 

Allows you to duplicate the selected sequence, but with the frames arranged in 

reverse order. 

 

         

 

 

Ping Pong 

Allows you to duplicate the selected sequence, but without duplicating the last 

frame, and with the rest of the frames arranged in reverse order. 

 

         

 

 

Frame Removal 

To remove or delete frames, move your cursor at the right end of a frame, or in the 

gutter between 2 frames. The cursor icon will change. Left-Click and Drag the cursor 

to the left and a confirmation window will pop up. Click OK to complete. 
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Cel and Layer Selection Bars 

The Cel and Layer Selection Bars works with the same concept of frames, layers and 
cels, but just displayed in a different manner. You can use the Cel Selection Bar to 
select the cel you want to work on. When a cel has been selected, the layers within 
the cel will be displayed in the Layer Selection Bar on the right.  
 

    

 

 

Layer / Cel Tabs  

 

Layer Header 

By holding down Left-Click and Dragging, you can reposition the specific layer and 

change the display order.  

Layer Name 

You can Left-Click Twice to rename the layer here. In addition, when there are too 

many tabs, by holding down Left-Click and Dragging Up or Down on this portion of 

the tab, you can scroll up and down the Layer Selection Bar. 

Layer Opacity Slider 

Similar to that in the Cel Bank, you can adjust the opacity level of the layer here.   

Layer Status Icons 

The layer status icons seen in the Cel Bank are also available here on the tabs. 

Cels Layers 

Layer Header 

Layer Name 

Layer Opacity 

Layer Status 
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In the Cel and Layer Selection Bars, you can Right-Click to access the context menu for 

adding and removing cels and layers. 

 

Frame Controls 

 

Frames can be easily created or removed using any of the Frame Control buttons 
located below the Canvas.  

 

Cel Addition and Removal Buttons 

Allows you to add or remove cels and layers in the Cel Bank. 

 

Cel Addition Menu  

This is another way to access the layer and cel creation functions.  

See Chapter 07 - Layer / Cel Creation. 

 

 

Cel Removal Menu 

This is another way to remove layers and cels.  

See Chapter 07 - Layer / Cel Creation. 
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Frame Addition and Removal Buttons 

Allows you to create/clear/delete frames without accessing the Cel Bank. 

 

Add new Key Frames to the Left / Right 

The first icon creates a key frame before the active frame, the second creates one 
after the active frame. This affects all layers in the same cel. 

   
In-between Frames 

The first icon creates an in-between frame before the active frame, the second 
creates one after the active frame. This affects all layers in the same cel. 

            
Duplicate Frame 

The first icon creates a duplicate frame before the active frame, the second creates 
one after the active frame. This affects all layers in the same cel. 

   
Clear Sheet 

Allows you to clear the strokes in the active sheet.  

   
Clear Frame 

Allows you to clear, or empty, all strokes in the active frame. This affects all the layers 

in the same cel. 

   
Clear In-between Frames 

Allows you to clear all strokes in the in-between frame sequence. This affects all in-

between frames within the same pair of key frames, as well as all the layers in the 

same cel. 

             
Delete Frame 

Allows you to remove the active frame from the cel sequence. This affects all the 

layers within the same cel. 

             
Delete In-between Frames 

Allows you to remove all in-between frames within a pair of key frames. This affects 

all the layers in the same cel. 

Deleting and clearing of selected frames can also be done en-mass to a group of 
selected frames.  

Multiple frames can be selected either with [ Ctrl + Left Click ] to select different 
frames or [ SHIFT + Left Click ] to select a range of frames. 
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CHAPTER 08 – Animating & In-betweening 

 

 

08 
Animating &  

In-betweening 
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Your Own Animation Assistant 

CACANi has been designed to harness the power of the computer in the hand-drawn 

animation workflow. With information from the key frames, in-between frames can 

be automatically generated and painted. At the same time, the artists retain full 

control of the process, by being able to adjust the frames as and when they need. 

Playback Bar 

When animating, it is important to preview the sequence constantly. Only by looking 

at the drawings in motion, will you be able to tell if the drawings are properly 

animated, or require further tweaking and adjustments.  

 

 

 

Go to Previous Key frame 

Moves the Playhead to the previous key frame.  

Go to Previous Frame 

Moves the Playhead to the previous frame. 

Current Frame / Time 

Displays the current active frame or time. In addition, you can scrub through the 

frames by left click and dragging on the frame number. Dragging right will move 

the playhead forward, while dragging left will move it backwards. 

Play / Stop 

Perform playback for the animation sequence. Click again to stop the playback. 

Go to Next Frame 

Moves the Playhead to the next frame. 

Go to Next Key frame 

Moves the Playhead to the next key frame. 

Frame Rate 

Sets the rate at which the sequence is played back. Click and drag on the number 

to change the frame rate during playback, or click on the number to key in a new 

frame rate. A negative frame rate will reverse the playback of the sequence. 

Playback Range Toggle 

When enabled, you can select the range of frames to playback.  

1 2 3 4 5 6 7 8 9 10 11 

1 

2 

3 

4 

5 

6 

7 

8 
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Range In and Range Out Frames Input 

Allows you to set the starting frame and the ending frame of the playback range. 

The frame numbers also correspond to the Range In and Range Out Tabs in the 

Timeline. 

Cycle Animation modes  

In Continuous mode, after the playback reaches the end of the animation 

sequence, it loops back to the first frame. 

In Ping Pong mode, after the playback reaches the end of the animation sequence, 

the sequence is played in reverse.   

 

 

Lightbox Panel 

The Lightbox Panel is used for referencing other frames when drawing for better 
accuracy in drawing. 

 

 

 

 

 

 
 
 
 

Lightbox Display Toggle 

Allows you to toggle on or off the onionskin images. 

To enable / disable onionskin images, click on the Lightbox Display Toggle on the 
Lightbox Panel. Alternatively, the Lightbox Display Toggle can also be found in the 
Display Property Bar.  

Colour Selection 

(Previous Onionskin) 

Reference Frame 

Onionskin Frame 

Number and Toggle 

Opacity 

Presets Menu 

Lightbox 

Display Mode 

Lightbox Display 

Toggle 

Colour Selection 

(Next Onionskin) 

Advanced 

Settings Menu  

Onionskin Opacity 

Bar 

Reset 

Menu 

Master Onionskin 

Opacity Bar 

Reset 

(Offpeg) 

Active Offpeg 

Frame 

Offpeg 

Frame 

Colour 

Selection 

(Offpeg) 

9 

10 

11 

Clear 

(Offpeg) 
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Lightbox Display Mode 

Allows you to change between Tint and Opacity display modes. Opacity mode also 

preserves the original colours of the images. 

  

 

 

Colour Selection (Previous Onionskin) 

Allows you to change the colour of onionskin images before the active frame. To do 

so, double click on the colour selection box and a colour selection dialog will appear.  

By default, onionskin images before the currently selected frame will be coloured 
green, those after the selected frame (8) will be coloured ochre brown.  

It is possible to change the colours of the onionskin images by double clicking on the 
colour selection boxes. This will trigger a dialog for onionskin image colour changes.  

 

Opacity Mode Tint Mode 
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Reference Frame 

Allows you to designate a frame for stroke matching. Because matching strokes are 

normally confined to adjacent key frames, this will allow you to match strokes to non-

adjacent frames.  

The Reference Frame is viewed as an onionskin image, either on the canvas or in the 

Navigator Panel, when Reference Frame mode is enabled. 

Onionskin Frame Number and Toggle 

Indicates the frame number relative to the active frame. Clicking on the number also 

toggles on the onionskin image. When toggled on, the opacity bar will be shown in 

colour.  

 

Onionskin Opacity Bar 

Allows you to change the opacity value of the onionskin image displayed on the canvas. 

Onionskin images further away from the selected frame will have lower opacity values 
by default, thus giving an appearance of fading away. The opacity values of the 
onionskin images can be changed by adjusting the onionskin opacity bars 
corresponding to the onionskin images.  

 

 

Master Onionskin Opacity Bar 

Determines the maximum opacity value of the onionskin images. 

Alternatively, the maximum opacity can also be changed by adjusting the Master 
Onionskin Opacity Bar.  

 

 

 



User Manual 

128 | P a g e  

 

Colour Selection (Next Onionskin) 

Allows you to change the colour of onionskin images after the active frame. To do so, 

double click on the colour selection box and a colour selection dialog will appear. 

Opacity Presets menu 

A list of presets that changes how fast the opacity values of the onionskin images 

fades. 

  

 

 

Advanced Settings menu 

 

When Show Key frames Only is enabled, the onionskin images will only reflect the 

key frames, and skip the in-between frames. 

When the currently selected frame is the last frame of the sequence, enabling Wrap 

Frames will allow you to see the onionskin image of the first frame. 

 

Reset menu 

Changes the colours of the onionskin images back to the default colours. 

 

 

Active Offpeg Frame 

Current Selected Offpeg Frame.  

Offpeg Frame 

Offpeg frame bars. Activated when an offpeg frame is toggled in the Cel Bank.  
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Colour Selection (Offpeg) 

Allows you to change the colour of the offpeg frames. 

Reset (Offpeg) 

Changes the scaling, position and rotation values of the active offpeg frame back to 

its original values.  

Clear (Offpeg) 

Removes the active offpeg frame. 
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Timing Panel 

In-between generation is one of the key functions in CACANi. Given two key frames 

depicting extreme poses of an action, intermediate frames, aka in-betweens, can be 

automatically generated by CACANi, creating a smooth motion. The Timing Panel 

provides flexible control of in-between frame generation.  

        

 

Add In-between Frame buttons 

Transition frames that are generated based on the key frames. Information between 

matching strokes in a pair of key frames is used to create in-between frames. The first 

icon creates an in-between frame before the active frame, the second creates one 

after the active frame. This affects all layers in the same cel. 

In-between Timing Bar 

Shows the timing of in-between frames in the current pair of key frames. By adjusting 

the position of the notches, it will allow you to change the speed of animation for the 

in-between frames. 

Auto Update Mode 

When enabled, in-between frames will be updated instantly whenever the timing is 

adjusted. However, this applies only to in-between frames that have been generated 

already, and does not apply to blank in-between frames. 

  

Add In-between 

Frame Buttons 

Remove In-between Frame 

Buttons 

 Lock 

Update All Cels Mode 

Generate In-betweens button 

Apply Timing Preset button 

In-between Timing Bar 

Auto Update Mode 

Selection Modes 

Timing Presets 

Active Layer Indicator 

In-between Timing Lock 

Update All Cels Mode 

Generate In-betweens Button 

Apply Timing Preset Button 
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Selection Modes 

Allows you to select which layers or cels are affected by the timing adjustments. 

Selected Layers  

When enabled, only selected layers are affected by the timing adjustments. 

All Layers in Cel 

When enabled, all the layers in the active cel are affected by the timing 

adjustments. 

All Cels 

When enabled, all cels with similar timing and frame types are affected by the 

timing adjustments. 

 

Timing Presets 

Provides you with a number of frequently used settings for quick timing adjustments. 

Click on the Timing Preset Button to update the In-between Timing Bar with the 

selected presets. 

Uniform 

In-between frame markers are spaced the same distance from each other. The 

motion between key frames will be at a constant speed. 

Accelerate 

In-between frame markers are spaced closer together as they approach the 

second key frame. The motion between key frames will be speeding up. 

Decelerate 

In-between frame markers are spaced further apart as they approach the second 

key frame. The motion between key frames will be slowing down. 

Accelerate -> Decelerate 

The spacing between in-between frame markers is further apart in the middle, 

and closer together when they approach the key frames on either side. The 

motion between key frames will be slowing down, then speeding up. 

Decelerate -> Accelerate 

The spacing between in-between frame markers is closer together in the middle, 

and further apart when they approach the key frames on either side. The motion 

between key frames will be speeding up, then slowing down. 
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Remove In-between Frame buttons 

The first icon allows you to remove the active in-between frame from the cel 

sequence. The second allows you to remove all in-between frames within a pair of key 

frames. This affects all the layers in the same cel. 

Active Layer Indicator 

Shows the current selected layer. 

In-between Timing Lock 

When enabled, the active in-between frame will be prevented from any changes or 

updating due to timing adjustments in the Timing Panel. However, you will still be 

able to manually adjust the strokes of the locked frame directly on the canvas.  

Update All Cels Mode 

When enabled, all cels are affected by the timing adjustments. However, this only 

applies to cels which have the same number of frames and frame type. 

Generate In-betweens button 

When clicked, it will generate in-between frames based on the settings in the In-

between Timing Bar. 

Apply Timing Preset button 

When clicked, any prior adjustments to the In-between Timing Bar will be cleared and 

the markers will be moved based on the Timing Presets. However, this does not alter 

the actual in-between frames. The frames will only be changed to the new timing if 

the Generate In-betweens button is clicked again, or if the Auto Update Mode is 

enabled. 
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Using the In-betweening Panel 

1. Create the 1st key frame 

Start by creating your first drawing in key frame 1.  

     

2. Switch on the Lightbox in the Display Bar     

 

3. Create the 2nd key frame 

Draw the second drawing in key frame 2, while taking note of the stroke matching 

arrow indicators in key frame 1. 

 

 

4. Create Blank In-between Frames 

Decide the number of in-between frames needed between the pair of key frames.  
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5. Adjust Timing for In-between Frames 

By default, the in-between frames have equal timing, hence the speed of the 

animation will be constant. However, movements in real life have irregular speeds. 

When the frame markers are nearer, the animation will speed up. When they are 

further apart, the animation will slow down. In this case, the animation is adjusted 

such that the movement speeds up.  

 

 

6. Generate In-between Frames 

After the timing is adjusted, click on the Generate button. In-between frames will now 

be created. In the example below, we can see the onionskin images of the in-between 

frames. Note that the spacing between them is not constant, which is a result of our 

timing adjustments earlier. 
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Navigator Panel 

The Navigator Panel provides a secondary view of your canvas, allowing you to pan, 

scale and rotate around the canvas. Another important feature of the Navigator, is 

that it can be used to display the Reference Frame, thus providing you with a way to 

match strokes without displaying everything in the canvas.  

 

 

 

 

 

 

 

 

 

Magnifying Tool 

Allows you to zoom in and out of the canvas. Left Click and Drag right to zoom into 
the canvas, Drag left to zoom out of the canvas. 

Magnification Level 

Allows you to key in the precise percentage of magnification. Left Click on the number 
to input any value from 1.6% to 6400%.  

Rotate Tool 

Allows you to rotate the canvas for easier drawing of strokes. Left Click and Drag right 
to rotate the canvas clockwise, Drag left to rotate anti-clockwise. 

Rotation Angle 

Allows you to key in the precise degree of rotation. Left Click on the number to input 
any value from -180° to 180°. 

Magnifying Tool Magnification 

Level 

Rotate Tool Rotation 

Angle 
Synchronise Pan 

(Reference 

Frame mode) 

Synchronise Zoom 

(Reference 

Frame mode) 

Preview Window 

Reference Frame 

Mode 

Active 

Frame 

Magnification 

Level Presets 

RF (Disable Preview 

Window Onionskin) 

Canvas Frame 
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Synchronise Pan (Reference Frame mode) 

When enabled in Reference Frame mode, panning in the preview window will affect 
the canvas as well.  

Synchronise Zoom (Reference Frame mode) 

When enabled in Reference Frame mode, zooming in and out in the preview window 
will affect the canvas as well. 

Preview Window 

Shows you a thumbnail view of the canvas.  

Canvas Frame 

Also allows you to pan the canvas. Left Click and Drag with the red frame to re-position 
the canvas window. 

Reference Frame Mode 

When enabled, the Reference Frame will be displayed in the preview window. This 
allows you to view and match strokes without the Reference Frame cluttering up the 
canvas.  

Active Frame 

Displays the active frame number.  

Magnification Level Presets 

Allows you to select preset values of the magnification level of the canvas. 

RF (Disable Preview Window Onionskin) 

When enabled, no onionskin frame will be displayed in the preview window. 

 

 

Using the Navigator Panel – Canvas Navigation 

  Please refer to Chapter 02 – Canvas Navigation. 
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Using the Navigator Panel – Reference Frame Mode 

In this mode, the Navigator allows you to view a frame that has been designated as a 

Reference Frame. As CACANi’s in-betweening system works by corresponding strokes 

in a pair of key frames, a Reference Frame refers to the key frame used for stroke 

matching in the current or active frame.  

 

   

 

 

 

This helps you to separate the strokes in the Reference Frame from the strokes you 

need to draw in the active frame. This is especially useful when the drawings are very 

complex. 

  

 

 

 

Navigator Normal Mode Navigator Reference Frame Mode 

Lightbox enabled, 

Navigator Normal Mode 

Lightbox disabled, 

Navigator Reference Frame Mode 
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Grey Out Matched Strokes Display Mode 

In conjuction with the Reference Frame Mode, this helps you to identify the remaining 

strokes to match. When enabled, strokes that are already matched or corresponded 

will be displayed as grey strokes, instead of the strokes’ original colour. 

 

 

  

 

 

 

Using the Feature Point Tool 

When generating strokes from a key frame, there are times when you will require the 

stroke to deform in a specific way. For example, when drawing smoke animation, the 

‘bump’ in a stroke should move through the stroke. That can be achieved with the 

Feature Point Tool. 

As an example, we have 2 key frames below, drawn with only 1 stroke: 

   

 

  The generated in-between frames (in red) will look like this: 

 

Matched Strokes (head) are still 

displayed as black strokes 

Matched Strokes are displayed as 

grey strokes 
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To create an effect where the ‘bump’ moves through the stroke, the in-between 

frames will look like this: 

 

 

To do so, use the Feature Point Tool to select the stroke in the first key frame. The 

second key frame is highlighted in green. 

 

Right-Click at the highest point of the ‘bump’ to bring up the context menu and select 

Add a Feature Point. A dashed path will appear, leading from the first key frame and 

ending on the second key frame. This indicates how the stroke moves at that point. 

   

 

  Move the ending point of the path to the bump on the second key frame. 

   

 

Generate the in-between frames this time will give you the following result. 

 

 

 

You can also adjust the path to modify the generation of the in-between strokes. 
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Stroke Groups 

Stroke Grouping allows you to manipulate multiple strokes at the same time. In 

addition, the Bone Tool will only work with groups, not individual strokes.  

Enabling Auto Group mode will cause each stroke to be grouped individually, so that 

bones can be created for each stroke. 

Strokes can be grouped in any type of frames. 

 

How to Group and Ungroup Strokes  

1. Stroke grouping can be done with the Selection tool. 

 

2. Select the strokes on the canvas. Take note that you can only group strokes on 

the same layer.  

 

 

3. Right-Click while hovering over any of the selected strokes. From the context 

menu, choose Group Selected. If the option does not appear in the context menu, 

it could be because you have selected strokes from multiple layers.  
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4. Strokes will now be grouped. The selection box is now orange. 

 

 

5. To ungroup, Right-Click while the group is selected. Choose Ungroup from the 

context menu. 

               

 

Bone Tool 

By default, the automatic generation of in-betweens is set to straight in-betweens. 

How, artists frequently utilise motion arcs for more natural animations. The extent of 

motion arcs can vary from animation to animation, and indeed, a single character 

usually has body parts moving with multiple motion arcs.  

The Bone Tool allows you a further level of optimisation and control in the generation 

of in-betweens. By specifying the motion arcs, in-betweens can be adjusted for more 

accurate animation.  

The Bone Tool can only be created and adjusted from groups in key frames. 
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Using the Bone Tool 

1. In this example, the character is turning his head. But the default generated in-

betweens make the animation very robotic. The head should be moving in an arc, 

not a straight line. 

 

 

2. Begin by selecting the strokes for the head with the Selection tool, then right 

clicking to group them. This is required as the Bone Tool is only usable in groups.  

 

 

3. After creating a group, select the Bone Tool. Click on the strokes in the group. A 

bounding box will appear around the strokes. At the same time, a second 

bounding box showing the same strokes in the next frame will be displayed in 

green. 
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4. With the group still selected, start the first motion arc by left clicking somewhere 

near the top of the bounding box and dragging a straight line to a similar area in 

the second bounding box. Upon release of the mouse, adjust the motion arc by 

moving your mouse while hovering. Left click again to confirm the arc. 

             

 

5. The second motion arc is drawn in the same way. For better results, it’s 

recommended to place the second arc near to the bottom of the bounding box. 

    

 

6. With that, the in-between frames can now be generated via the Timing Panel. 

Compared to the original in-between frames, the new ones now move according 

to the motion arcs described by the artist. 

 

Bones can only be created on key frames, and will only affect the in-between frames 

within a pair of key frames. As such, separate bones and motion arcs will have to be 

created for the next pair of key frames. 
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Synchronising Multiple Bones 

When multiple groups are created, each can have a set of bones. In this case, it’s 

important to synchronise the movement of the bones. 

In this example, the body and head are in different groups. To synchronise the body’s 

bone movement to the head, select the body group with the Bone Tool and press Ctrl. 

All the motion paths will be highlighted. 

        

Left Click on the highlighted motion path to synchronise the body group with the head 

group. Create the second motion path near the bottom of the body. The body group 

is now synchronised with the head group. 
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Retain Stroke Connections 

The Retain Stroke Connections function is a tool to help minimize unwanted stroke 

gaps in generated in-between frames. This will make it easier for artists to paint the 

in-between frames at a later stage. The function can be found in the Menu Bar, under 

the Tools menu. 

 

 

When an end of a curve falls on another curve, they form a T intersection as shown in 

the figure below.  

 

This function first detects T intersections in key frames. When found, it generally 

means that the strokes are connected to each other, and will form regions. Based on 

this information, CACANi will try to ensure that the same strokes are connected in the 

automatically generated in-between frames as well.  

 

 

 

Using the Retain Stroke Connections Function 

1. The example below shows a simple sequence with 2 key frames and 2 generated 

in-between frames. 
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2. You will be able to notice that in the in-between frames, the blue separation 

stroke does not touch the black outline, unlike the key frames.  

         

 

 

 

3. Select Tools > Retain Stroke Connections. Since T intersections can be found in 

key frames 1 and 2, the function will automatically close the gaps between the 

strokes in in-between frames 1 and 2. 

 

 

 

4. The stroke gaps are now closed and the in-between frames are ready for painting. 

 

Key frame 1 In-between 1 In-between 2 Key frame 2 

Gap in In-between 1 Gap in In-between 2 

Key frame 1 In-between 1 In-between 2 Key frame 2 
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Guidelines for In-betweening 

CACANi’s unique in-betweening technology allows strokes to be automatically 

generated in in-between frames. However, to get the best results, there are a few 

guidelines to follow when drawing your key frames. 

 

Separate Strokes for Different Parts 

When drawing in CACANi, it is recommended to try to relate each stroke to a part of 

the object or character you are creating. In the example below, you can recognize that 

the object comprises of 2 distinct parts, the lid and the can. By drawing separate 

strokes (represented with different colours) for the lid and can, it will be easier for 

you to in-between the opening of the lid automatically.  

 

 

 

 

Conversely, if you had drawn the lid and can with only 2 strokes (1 orange stroke and 

1 blue stroke), the in-betweening result will not be good.  

 

 

 

 

 

Generated In-between Frames 

Generated In-between Frames 
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In-betweening Sharp Angles 

When drawing an object or a character with sharp angles, like the example below, it 

is recommended to have separate strokes as well. This will help maintain the sharp 

angles in the in-between frames. 

 

 

 

 

It is harder to generate in-between frames accurately when there are multiple sharp 

angles within a stroke. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Generated In-between Frames 

Generated In-between Frames 
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Corrective Features for Stroke In-betweening 

It is inevitable that mistakes will be made when cleaning up key frames in CACANi. For 

example, strokes were drawn in the wrong direction, or in the wrong order. When 

that happens, you can make use of corrective features like Change Direction and In-

between Selected, found in the Selection tool’s context menu. 

In the example below, one stroke is flipped in the generated in-between frames due 

a problem with stroke direction in the key frames. 

 

 

To view the stroke direction, use the Selection tool to select the stroke in the key 

frames. 

     

 

Still using the Selection tool, Right Click on the stroke in the first key frame to bring 

up the context menu. Choose Change Direction. 

               

Generated In-between Frames 
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After changing stroke direction, the stroke can be updated in the in-between frames 

using the In-between Selected option, without affecting the other strokes. This is 

especially useful in cases when there have been extensive changes made to the 

strokes in the in-between frames. 

 

 

With the corrections, now the in-between frames are generated properly. 

         

 

 

Hiding Stroke Segments Last 

During the process of animating, there is always a high chance that the strokes in the 

key frames or in-between frames need to be changed. As such, it is generally a good 

practice to leave any stroke segment editing / hiding to when the key frames are 

almost finalized, or after the in-betweening process has been carried out.  

Keeping this in mind will help minimize time spent in the re-editing of stroke segments. 
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CHAPTER 09 – Painting Your Animation 

 

 

09 
Painting Your Animation 
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A Dash of Sunshine 

With all the innovation found in the in-betweening tools, we have tried to do the same 

with the painting process, by leveraging on the key frame information gathered earlier. 

As a result, CACANi has an intelligent painting system that will help you to paint 

animation frames automatically.   

But before continuing with the different painting tools, there is a need to understand 

how painting works in CACANi. On the canvas, before painting can be done, you must 

ensure that the strokes form closed regions. That can be done with the Clean Up Tool, 

or you can use the Stroke Editor to adjust the strokes so that they cling to each other. 

  

Please refer to Chapter 05 – Stroke Editor and Chapter 05 – Clean Up Tool for 

different ways to prepare for painting. 

 

 

You can use the various region display modes to check if the regions are indeed closed. 

 

 

Please refer to Chapter 06 – Region Display Modes for more information on different 

ways of displaying regions. 
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Cross-Layer and Self-Layer Regions 

Next is the concept of cross-layer regions and self-layer regions. In this example, as 

the strokes were all drawn in 1 layer, the region formed by the 4 strokes is a Self-Layer 

Region, or Self Region. The Self Layer Paint Tool is used to fill in the region. 

 

 

 

To verify this, you can enable the Highlight Self-Regions display mode. All self-regions 

will be displayed with a checkered pattern. 
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On a new layer, a green stroke is drawn. This new stroke does not affect the self-

region underneath.  

 

 

 

Rather, because the new layer is above the self-region layer, it intersects with the first 

4 strokes and creates 2 distinct new Cross-Layer Regions. This is apparent when using 

the Cross Layer Paint Tool results in the new light blue region.  
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The self-region still shows the checkered pattern, while the light blue cross-layer 

region doesn’t. In this case, as the green stroke is above the other 4 strokes that form 

the self-region, the cross-layer region hides the self-region. 

 

 

 

 

By reversing the order, now the 4 strokes are above the green stroke. As a result, the 

orange self-region is now hiding the light blue cross-layer region, as well as the green 

stroke. In Highlight Self-Regions display mode, the translucent self-region reveals the 

cross-layer region. 
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Taking the example further, another green stroke is added to the bottom layer, 

connecting the first green stroke in the bottom layer to the black stroke in the top 

layer. 

 

 

 

 

Because the strokes that make up this region belong to different layers, there is no 

self-region formed. Using either the Cross Layer Paint Tool or the Self Layer Paint Tool 

will result in a cross-layer region with no checkered pattern.  
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Another difference between self-regions and cross-layer regions is the layer where 

the colour information is stored. Since self-regions are formed by strokes on a single 

layer, the colour information is naturally stored together in the same layer.  

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Self-region colours (stored in 

top layer) hiding Cross-Layer 

region colours (stored in 

bottom layer)   

When top layer is hidden, Self-

region colours disappear, but 

bottom Cross-Layer region 

colours remain 
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However, as cross-layer regions are formed by strokes from different layers, colour 

information is stored in the bottom-most layer. Understanding this is important, 

especially when attempting to hide layers. 

 

   

 

 

 

 

  

‘Green strokes’ layer moved to 

top layer, Self-region colours 

moved to bottom layer 

together with strokes 

Cross-layer region and Self-

region colours now stored 

together in bottom-most layer 

and are both hidden at the 

same time 
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Colour Panel 

The Colour Panel is where you can define or change colours for selected strokes and 

regions. You can also store colour swatches for adjustments or testing.  

 

 

  

Active Stroke Swatch 

Active Region Swatch 

Quick Access Stroke Palette 

Quick Access Region Palette 

Colour Palette 

  

Colour Selection Tabs 

 

           Colour Wheel 

 

 

Alpha Slider 

 

HSV Colour Sliders 

 

RGB Colour Sliders 

 

Colour Mixers 
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Active Stroke and Region Swatches 

When active, it’ll allow you to set or change the colour of the selected strokes or 

region.  

 

 

To change stroke colours, use the Selection tool to select the strokes.  

 

 

[ Left Click ] on the Active Stroke Swatch to make sure that the colour adjustment will 

apply to strokes and not regions.  

 

 

Enable the Colour Wheel Selection Tab [CW]. [ Left Click and Drag ] the circular 

indicator to a different colour in the colour wheel. The colour in the Active Stroke 

Swatch is now changed.  
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The colour of the selected stroke on the canvas is also changed. 

              

 

Unlike strokes, regions cannot be selected. [ Left Click ] on the Active Region Swatch 

to make sure that the colour adjustment will apply to regions and not strokes.   

 

 

Adjust the indicator on the colour wheel to change the colour in the Active Region 

Swatch. 
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Select the Cross Layer Paint Tool and [ Left Click ] on a closed region on the canvas to 

fill it with the selected colour. 

   

 

Quick Access Stroke and Region Palettes 

Allows you to select swatches quickly from the dropdown menus in the stroke drawing 

tools or Cross Layer Paint Tool property bars. With the quick access palettes, 

frequently used colour swatches can be accessed from the property bar, and the need 

to have the Colour Panel opened all the time is reduced.  

   

 

To add swatches to the quick access palettes, open the Colour Panel. [ Hold ALT and 

Left Click ] on any of the empty quick access swatches. 

   

 

 

 

 

Quick Access Stroke Palette 

 

 

Quick Access Region Palette 
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To use the quick access swatches, select any of the Drawing Tools, Painting Tools or 

the Selection tool. [ Left Click and Hold ] on the Colour Selection Box in the property 

bars. [ Left Click ] on a quick access swatch, and it will replace the colour in the Active 

Swatch. 

 

 

 

Colour Palette 

Allows you to store colour swatches for easier selection. 

 

 

To add a swatch to the colour palette, first select a colour from either the colour wheel 

or the colour sliders.  

 

 

Then [ Hold ALT and Left Click ] on one of the empty swatches in the colour palette. 

The colour is now added. 

 

Quick Access Stroke Palette 

Quick Access Region Palette 
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Colour Selection Tabs 

Allows you to display or hide the colour wheel and various colour sliders. 

 

 

 

Colour Wheel [CW] 

Allows you to define colours for the Stroke or Region Swatches through visual 

selection. The colour wheel consists of an outer colour circle, and an inner brightness 

square. Enable the colour wheel by [ Left Clicking ] on [CW]. 
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To vary the brightness of a selected colour, [ Left Click and Drag ] the circular indicator 

on the brightness square. To change the selected colour, [ Left Click and Drag ] the 

rectangular indicator on the colour circle.  

     

 

Alpha Slider [A] 

Allows you to define the alpha, or transparency, value of a colour for the Stroke or 

Region Swatches. To change the alpha value of selected strokes, enable the Alpha 

slider by [ Left Clicking ] on [A]. 

 

 

Adjustments can be made by either [ Dragging ] the triangular indicator, or by [ Left 

Clicking ] on the input field to key in the new value directly. 

  OR  
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Colours with different alpha values can also be stored as swatches in the Colour 

Palette. 

 

 

 

HSV Sliders [HSV] 

Allows you to define colours through the adjustment of H (hue), S (saturation) and V 

(black level) values. Enable the HSV sliders by [ Left Clicking ] on [HSV]. 

   

 

TIP!  It’s easier for artists to select colours using the HSV sliders than the RGB 

sliders, mainly because HSV sliders are visually easier to understand. 

 

RGB Sliders [RGB] 

Allows you to define colours through the adjustment of R (red), G (green) and B (blue) 

values. Enable the RGB sliders by [ Left Clicking ] on [RGB]. 
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Colour Mixers [CM] 

Allows you to define colours through the mixing of two user-assigned colours on 

either end of the slider. Enable the colour mixers by [ Left Clicking ] on [CM]. 

 

 

To assign colours to the mixers, you will first need either the colour wheel or the 

colour sliders. The HSV sliders are used in this example.  

Adjust the sliders to a colour of your desire. Apply the colour by [ Left Clicking ] on 

one of ends of a colour mixer.  

    

 

Select another colour, and then apply the second colour to the other end of the same 

colour mixer.  
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Now you can adjust the circular indicator to get a new colour mixed from the selected 

colours. Keep this new colour by [ Holding down Alt and Left Clicking ] on the colour 

palette.   

 

 

 

Colour Picker Tool 

Allows you to sample colours from the canvas. The colours can be from a stroke or 

region on the canvas, or from a loaded image in the Reference Image Layer. 

Using the Colour Picker Tool 

Select the Colour Picker Tool and [ Left Click ] anywhere on the canvas. The colour at 

the spot will be reflected in the Active Swatch in the Colour Panel.  

   

 

Cross Layer Paint Tool and Self Layer Paint 

Tool Difference 

The main difference between the Cross Layer Paint Tool and the Self Layer Paint Tool 

is the latter’s ability to determine and paint self-regions.  
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The Cross Layer Paint Tool does not determine whether strokes are forming self-

regions and can only create cross-layer regions. Hence, it is more useful and efficient 

when painting elements that do not require regions to hide, or occlude, each other.   
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Cross Layer Paint Tool / Self Layer Paint Tool 

Allows you to fill a closed region with the selected colour by [ Left Clicking ] or 
[ Dragging ] on the region.  
 

 
 
 

Using the Cross Layer Paint Tool 

To paint a closed region, first pick a colour using the Colour Panel’s palettes or colour 
sliders, then [ Left Click ] within the region.  
 
To remove colour from a painted region, [ Right Click ] within the region.  

   
 
 

You can also use drag selections to paint multiple regions, or remove colour from 
multiple painted regions. To do so, [ Left Click and Drag ] a rectangular selection over 
regions to be painted. Any region that falls within the selection will be filled with the 
same colour.  
 
Conversely, to remove colours from multiple painted regions, [ Right Click and Drag ] 
a selection over them. 
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TIP!  When painting regions, you may find that certain regions cannot be painted. 
One reason for this may be that the strokes forming the region have gaps 
amongst them.  

( For more information, see Chapter 05 – Clean Up Tool ) 
 
 

 

Sampling Colours from a Reference Image  

Other than selecting colours from the Colour Panel, you can also toggle the Colour 

Picker Tool from within the Cross Layer Paint Tool. Colours can be sampled from 

drawings created in CACANi as well as reference images loaded from external sources.  

First, load a reference image into CACANi.  

( For more information, see Chapter 07 – Reference Layers ) 

   

 

With the Cross Layer Paint Tool selected, [ Hold ALT + Left Click ] on the coloured 

image, then [ Left Click ] on the character’s face. The face is now painted with the 

colour sampled from the reference image.  

                  

  

In this way, artists will be able to quickly sample colours from reference images and 

reduce the need for the Colour Panel. 
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Cross Layer Paint Tool Properties 

Cross Layer Paint Tool has similar properties with Self Layer Paint Tool. 

 

 
 

 
 

Replace Existing Colour 

When enabled, you will be able to replace colours in painted regions.  

Region Colour Selection Box 

You can set the region colour by [ Left Clicking ] twice to bring up the Colour 

Selection Box dialog box. When done, just [ Left Click ] OK to confirm. 

 

 

Using the Colour Reference Window 

Other than loading the images into a reference layer, you can also use the Colour 

Reference Window ( Menu > Tools ) to load your images. 

   

 

From the Colour Reference Window, you can Left Click on the Load Image icon to bring 

up the selection dialog box to load an image. 

 

  

1 2 

1 

2 
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When you Left Click anywhere on the loaded image, the colour value at that pixel is 

sampled and automatically recorded as an active swatch in the Colour Panel.  

 

 

 

 

Using the Cross Layer Paint Tool, you can proceed to paint the corresponding regions 

in the canvas. 
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Assisted Painting System 

Painting animation frames has always been a time consuming process, even on a 

digital, paperless workflow. However, CACANi’s assisted painting feature will allow 

you to finally surmount this obstacle. By taking a painted frame as reference, CACANi 

can automatically paint the rest of the animation sequence for you, helping you save 

time and money.  

Auto Colouring Panel 

The Auto Colouring Panel provides you with tools to paint the frames easily. Activate 

it from the Panel Display Bar. 

 

 

 

 

 

 

Apply To All Cels mode 

When enabled, Auto Colour Other Frames, Auto Colour Current Frame, Update 

Region Colours and Clear Region Colours will affect all cels. 

Auto Colour Other Frames  

The painted regions of the current frame will be used to paint all other frames or 

frames in a selection. 

Auto Colour Current Frame 

Regions in the active frame will be painted with colours from the previous frame, or 

adjacent frames.  

 

Apply to all Cels 

mode 

Replace Existing 

Colour mode 

Auto Colour Other 

Frames 

Apply to All Frames 

mode 

Update Region 

Colours 

Auto Colour Current 

Frame 

Exclude Selected 

Frames mode 

Clear Region Colours 
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Replace Existing Colour mode 

When enabled, Auto Colour Other Frames and Auto Colour Current Frame will 

replace colours in painted regions when applied. 

Update Region Colours  

If the regions of the selected frame are already painted, this will restore the display 

of the colours in those regions. 

Clear All Region Colours  

When pressed, all region colours in the selected frame will be erased. 

Apply To All Frames mode 

When enabled, Update Region Colours and Clear Region Colours will affect all the 

frames within the active layer.   

Exclude Selected Frames mode 

When enabled, Update Region Colours and Clear Region Colours will not affect the 

selected frames within the active layer. 

 

Using Auto Painting 

First, ensure that the regions to be painted in the animation frames do not have any 

unwanted gaps. This can be done by using the Cross / Self Layer Paint Tools and Left 

Clicking on any open areas to check for unclosed regions. 

 

 

Select one of the animation frames and paint it. This will provide CACANi with the 

painting information for the rest of the animation sequence.  
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With the painted frame active, select the Auto Colouring Panel. Left Click on Auto 

Colour Other Frames. CACANi will now analyse and paint all other prior and 

subsequent frames in the animation sequence automatically. 

 

 

IMPORTANT: The auto colouring process is based on matching strokes. If the regions 

are enclosed by the same strokes in all the frames, the auto colouring will be very 

accurate. In the example below, the character’s head is based on the same stroke 

indices 01-05. 

 

 

So, the colour regions enclosed by the same strokes in the head will be successfully 

painted automatically.  

In addition, it is useful to understand how the auto colouring process works. From the 

1st painted frame, it will be used to paint the 2nd frame. The 2nd frame will be used to 

paint the 3rd frame. The process continues until there are no more frames. 

If there are still unpainted regions, you can use the Cross / Self Layer Paint Tools to 

manually paint those regions. 
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Auto Paint Single Frames 

In the event that a new frame is created, or some adjustments were made to a painted 

frame, you can repaint the frame automatically without affecting the rest of the 

sequence. 

Select the unpainted frame. 

 

  

Apply Auto Colour Current Frame from the Paint / Self Layer Paint Tools. The selected 

frame will be painted based on the nearest painted frame.  

 

 

 
 

TIP! Auto Colour Current Frame is very useful when there are more complex 

drawings. You can check the painted frames one by one before applying Auto 

Colour Current Frame to the next frame.  
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CHAPTER 10 – Completing Your Animation 

 

 

10 
Completing Your 

Animation 
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Saving the Animation 

 

From the menu bar, select File > Save As. Alternatively, press [ Ctrl + SHIFT + S ] to 
save a file. A File Save As dialog box will appear. 

 

    
 

You will be required to enter a file name for their files. You can also choose the file 

format to save in.  

 
The CACANi Documents format (*.cacs) is the default file format for CACANi. All file 

information is saved. 

 
The CACANi Documents Xml format (*.cacx) is a simplified file format where only 

essential file information are saved. It is suitable for exporting CACANi files to different 

versions of CACANi. 
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Exporting Images 

 

From the menu bar, select File > Export Image. An Export Image Dialog box will 
appear. 

 

 
 
A thumbnail window shows the current selected frame. 
 

File Information 

Directory 

Allows you to save their file in the default Documents folder, specify your own folder 
location, or use [ Browse ] to select another folder of your preference. 

File Name and File Type 

You will be required to type in your preferred filename in the text field. You can 
choose the default png image format, or select a different format from the dropdown 
menu. CACANi supports png, jpg, bmp, tiff and tga formats. 
 

File Counter 
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This allows you to assign a naming convention and appends a numeric value to the 

end of each frame’s filename when they are exported from CACANi. This is only 

configurable when All Frames or Selected Frames are selected in the Frames property. 

 

Output Settings 

Canvas View 

When selected, the export resolution defaults to the current resolution of the CACANi 

canvas. 

Camera View 

When selected, the export resolution defaults to the current resolution of the CACANi 

camera. 

Resolution 

A set of resolution presets. Larger resolutions will result in sharper images, at the 

expense of larger file sizes. 

Width and Height 

You can manually specify the width and height of the exported image, in pixels. 

Lock Proportions 

When enabled, the aspect ratio of the exported image will be kept similar to that of 

the previous aspect ratio defined in the Width and Height fields. 

Anti-Aliasing 

When enabled, strokes in the exported images will be anti-aliased and will look 

smoother. 

Render Strokes 

Disabling this option will result in the exported image showing the painted regions 

without the strokes. 

 

Background 

When enabled, all exported images will have an opaque white background. 

 

Trim Offsets (range only) 

When enabled, frames that have no visible information are not exported. 
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Export Range: 

Users can choose between:  

Active Frame  

Exporting only the active frame shown on the canvas as an image. 

All Frames  

Exporting all the frames in the animation sequence as an image sequence. 

Selected Frames  

Exporting a selected range of frames as an image sequence. 

 

Stroke Magnification 

When enabled, strokes in the exported images can be thickened or thinned with the 
percentage slider, without affecting the original artwork. 

 

 

 

 

 

 

 

END  
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All images used on the covers of this manual are the property and copyright of their 

respective owners.  

 

All rights reserved. No part of this manual may be copied or reproduced in any form or by 

any means without written permission from the publisher. 
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